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1
Overview—Choosing a Method to Manage

Terminals

Chapter Overview This chapter introduces two methods for managing the operating
settings of VXT 2000 windowing terminals in your network from
a central location:

• The terminal’s configuration manager

• Host-based resource files (using TCP/IP)

You can use this chapter to help you choose the method best
suited for your network and working style. The next two chapters
describe each method in detail.

1.1 Two Methods—The Configuration Manager or Host-Based
Resource Files

Overview Before you choose a method for managing VXT 2000 windowing
terminals, you should understand how the terminal stores
and applies customized settings. When you boot a VXT 2000
windowing terminal, it applies the customized settings from a
resource file.

• By default, a terminal reads its customized settings from its
native resource file. Host-based terminals store the native
resource file in the terminal’s nonvolatile memory (NVRAM),
while server-based terminals use an InfoServer system.

The native resource file stores the customized settings entered
by users in the terminal’s dialog boxes. You can centrally
manage the native resource files for all terminals on your
network by using the configuration manager from a single
terminal. You cannot edit the native resource file directly.

• You can also create host-based resource files that reside
on a host system. If you use host-based resource files, they
override settings in the native resource files.

Configuration
Manager

The configuration manager is a VXT local client accessed from the
Customize menu of the Terminal Manager window.

• For server-based terminals, you can use all features of the
configuration manager. You can

– Customize and manage terminals individually or in work
groups.

– Copy, back up, and delete terminal or work group settings.

VXT Software: Managing Terminals and Work Groups 1–1
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– Move terminals among work groups.

– Create, copy, or remove font sets from InfoServer systems.

– Lock or unlock terminal or work group settings.

Work group passwords provide security.

• For host-based terminals, you can use some features of the
configuration manager. You can

– Customize individual terminals.

– Copy settings from one terminal to another.

– Back up terminal settings (if you have an InfoServer
system)

– Lock or unlock terminal settings.

Terminal passwords provide security.

When you change a terminal’s customized settings in the
Configuration Manager dialog boxes, the changes are written
to the terminal’s native resource file. See Chapter 3, Using the
Configuration Manager.

Host-Based Resource
Files (Using TCP/IP)

Alternatively, you can create your own host-based resource files
and store them remotely on a host system that uses TCP/IP. You
must enable TCP/IP on the terminal and enter a path to the
file on the host system. The terminal can use the TFTP or NFS
transport to access the file.

Host-based resource files

• Work with host-based terminals and server-based terminals.

• Provide access to all resources available in the configuration
manager.

• Can be terminal or group files. For host-based terminals, this
means you can create group files that you cannot create with
the configuration manager.

• Override native resource files when you reboot the terminal.

A customized group file overrides a native group file, while
a customized terminal file overrides a native terminal file.
In other words, the customized terminal file overrides user
settings entered in dialog boxes.

• Can include resources for other features such as the local
Motif window manager.

You edit host-based resource files directly, rather than accessing
them through a graphical user interface such as the configuration
manager. You enter resource data in the X resource manager
(Xrm) format.

1–2 VXT Software: Managing Terminals and Work Groups
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1.2 Managing Host-Based Terminals

Comparing the Two
Methods

Figure 1–1 compares the use of the configuration manager and
host-based resource files for managing host-based terminals.

If you decide to use host-based resource files, you may want to
limit your use of the configuration manager. Otherwise, you will
have two sets of customized settings to manage. You may decide
to use the configuration manager only to enter the location of your
host-based resource files in the Customize Resource Files dialog
box.

Figure 1–1 Managing Host-Based Terminals

System Manager

Users

Use the configuration manager
to enter settings for individual
terminals.

Using the Configuration Manager

Settings are written directly to
the terminal’s native resource
file in NVRAM. The file also
stores settings entered by the
user.

When you reboot the terminal,
it applies settings in this order:

System Manager

Host

Users

TCP/IP
(TFTP or NFS)

When you reboot the terminal,
it applies settings in this order:

1. The group resource file on the host.

2. The terminal’s native resource file
    in NVRAM.

3. The terminal resource file on the
    host.

Using Host−Based Resource Files

Create host−based resource
files for groups and individual
terminals.

The terminal’s native resource file
in NVRAM.

LJ−03546−RAGS
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Effect on Customized
Settings

Figure 1–2 shows how a host-based terminal determines its
customized settings, depending on the management method
you choose. The figure uses the screen background and display
language for examples. As you move from left to right, the new
setting overrides the previous setting. The figure shows the use of
both group and individual terminal resource files. You have the
flexibility to use only group files or only individual terminal files.

Figure 1–2 Customized Settings (Host-Based Terminals)

Using Host−Based Resource Files  +  Configuration Manager

Setting
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RebootingTerminal

Host−Based
Group
Host−BasedDefault

Setting
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Display
Language
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English         French               English                 −−                      English

User or
Configuration
Manager 
Terminal *

* The terminal’s native resource file stores the last saved setting 
   −− either by the user or by the system manager in the configuration
   manager. LJ−03548−RAGS
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Using the Configuration Manager
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Using Host−Based Resource Files
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1.3 Managing Server-Based Terminals

Figure 1–3 compares the use of the configuration manager and
host-based resource files for managing server-based terminals.

If you decide to use host-based resource files, you may want to
limit your use of the configuration manager. Otherwise, you will
have two sets of customized settings to manage. You may decide
to use the configuration manager only to enter the location of your
host-based resource files in the Customize Resource Files dialog
box.

Figure 1–3 Managing Server-Based Terminals

Using the Configuration Manager

System Manager

Use the configuration manager to
enter settings for terminals and
work groups.

Users

InfoServer

1. The native resource file for the work group.

2. The native resource file for the terminal.

Settings are stored in native resource
files (terminal or work group) on an
InfoServer system. The native resource
file for a terminal also stores settings
entered by the user.

When you reboot the terminal,
it applies settings in this order:

System Manager

Users

Host
and terminal resource files.

TCP/IP
(TFTP or NFS)

When you reboot the terminal,
it applies settings in this order:

1. The native resource file for the work group.

2. The group resource file on the host.

3. The native resource file for the terminal.

4. The terminal resource file on the host.

Create host−based group

Using Host−Based Resource Files

LJ−03547−RAGS

Effect on Customized
Settings

Figure 1–4 shows how a server-based terminal determines its
customized settings, depending on the management method
you choose. The figure uses the screen background and display
language for examples. As you move from left to right, the new
setting overrides the previous setting. The figure shows the use of
both group and individual terminal resource files. You have the
flexibility to use only group files or only individual terminal files.
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Figure 1–4 Customized Settings (Server-Based Terminals)
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1.4 Summary

The following table summarizes the features of the configuration
manager and host-based resource files.

Configuration Manager Host-Based Resource Files

Attributes � Graphical user interface.
� Settings are stored in native
resource files.

� Text files created by user.
� Files are stored on a host system.
� Settings override native resource files.
� Requires TCP/IP.

Host-Based
Terminals

� Can manage terminals.
� Can copy terminal files.
� Can manage InfoServer font sets.
� Native resource file is in terminal’s
NVRAM.

� Can manage terminals and work groups.
� Can include other resources and files.

Server-Based
Terminals

� Can manage terminals and work
groups.
� Can manage InfoServer font sets.
� Can copy, delete, back up, and move
terminal and work group files on
InfoServer systems.
� Native resource file is on InfoServer.

� Can manage terminals and work groups.
� Can include other resources and files.
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Using Host-Based Resource Files

Chapter Overview This chapter describes how to create and use host-based
resource files to manage VXT 2000 windowing terminals. Host-
based resource files are an alternative to using the terminal’s
configuration manager.

For an overview of host-based resource files and the configuration
manager, see Chapter 1, Overview—Choosing a Method to
Manage Terminals.

TCP/IP Required You place host-based resource files on a host system that uses
TCP/IP. Set up TCP/IP as described in the section for your host
operating system in this guide.

Individual terminals must have TCP/IP enabled in the Terminal
Manager window’s Customize TCP/IP dialog box. To access the
files from the host, terminals use the TFTP or NFS transport.

2.1 Host-Based Resource Files

Host-based resource files are text files that contain a list of
parameters and values, called resources. Most resources
correspond to the features in the terminal’s dialog boxes. Resource
names are comparable to the names of buttons and fields in the
dialog boxes. You can also add resources for other features, such
as the local Motif window manager.

Text Editors You create and edit host-based resource files with a text editor,
rather than accessing them through a user interface such as the
configuration manager. You can include some VXT resources or
all VXT resources, depending on what settings you want to control
from the host.

Xrm File Format Host-based resource files use the X resource manager (Xrm)
syntax. See Section 2.10 for syntax examples.

vxtcfgtmpl.xrm
Template File
Provided

VXT Version 2.1 software installation kits for ULTRIX,
DEC OSF/1 AXP, and UNIX systems provide a template resource
file named vxtcfgtmpl.xrm. The template file contains the names
of available VXT resources and their default values.

Section 2.10 shows the template resource file.

VXT Software: Managing Terminals and Work Groups 2–1
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Individual, Group,
and Composite Files

You can create an individual resource file for each terminal.
You can also create a group resource file to share among
terminals or work groups. Values specified in the individual
resource file override those specified in the group resource file.

You can create a single composite resource file if you want to
store several individual or group resource files in the same file.
Each included file is identified by a unique key name (Section 2.3).

Effect on Dialog
Boxes and the
Configuration
Manager

VXT 2000 windowing terminals store user settings from dialog
boxes (including the configuration manager) in native resource
files. When you boot a VXT 2000 windowing terminal, the
settings in host-based resource files override the settings in the
native resource files.

Entering a setting in a host-based resource file effectively locks
that feature, preventing users from saving a new setting in a
dialog box. Users can make temporary changes that remain in
effect until the next time the terminal is booted.

Note

The terminal may ignore the settings in host-based
resource files if the resources are locked in the
configuration manager. See Chapter 3, Using the
Configuration Manager for details.

2.2 Creating Individual and Group Resource Files

You can create host-based resource files with any text editor. You
can edit the template resource file (Section 2.10) or create your
own resource file. To activate a resource file for a terminal, you
designate the file as a terminal file or group file in the terminal’s
Customize Resource Files dialog box.

Template File Format The template file begins with basic syntax rules, followed by many
VXT resources. Resources are grouped into three sections:

• VXT specific resources (corresponding to dialog boxes)

• Common application resources

• VXT local application resources

Each resource begins on a new line. Below each resource is a list
of all possible values and the default value. Initially, all lines are
commented out by a comment character (!). For example, here is
the entry that controls the order of mouse (pointer) buttons:

! Vxt.xserver.pointer.buttonOrder:
! Default: right Values: right, left (handed)

2–2 VXT Software: Managing Terminals and Work Groups
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To make a resource active, you remove the comment character
and enter the desired value. For example, to set the pointer
button order for a left-handed user:

Vxt.xserver.pointer.buttonOrder: left
! Default: right Values: right, left (handed)

Activate Customized
Settings Only

Resource files should contain active settings only for resources
that you want to customize. There is no need to activate system-
default settings in resource files. One exception is when a group
file contains a customized setting for a resource and you want a
particular terminal in the group to use the system-default setting;
in this case, you could activate the system-default setting for that
resource in the individual terminal resource file.

2.2.1 Resource
File Syntax

Resource files can contain resource items, comments, and
commands to include other files (Section 2.2.2). Each entry
begins on a new line.

• A resource item consists of a resource name followed by a
colon (:) and a value or list of values, terminated by a new line
character.

name:value

Example:

Vxt.xserver.backingStore:enable

• A comment line consists of exclamation point (!) followed by a
text comment.

!comment

Example:

!Resource names are case-sensitive.

You can use comments to explain why you set a resource to a
specific value, or to record a history of changes.

Syntax Rules • Resource names are case-sensitive. You must use the exact
case.

• Values are not case-sensitive, except in specific cases such as

– Text strings

– File names

• You can use spaces and tabs in values.

• You can use commas to separate items in a list.

• If you need more than one line for a resource, use the
backslash (\) at the end of a line to continue to the next line.

• Many resources accept the value default, which assigns the
factory-default value to a resource.

VXT Software: Managing Terminals and Work Groups 2–3
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• If you omit a resource or leave it commented out, the terminal
uses the default value or the value specified in the group
resource file (if there is one).

If you omit the resource value, the value is set to null. The
result depends on the resource.

Sample Resource File Here is an example of a simple resource file, with comment lines
removed:

! Sample Resources file
! Vxt.language: fr
" Vxt.create.autoStart: "Vxt Create" f.title\n\

"Term Mgr + Msg Box" f.exec "term_mgr -msgbox"\n\
"Motif WM" f.exec "mwm"\n\
"LAT DECterm on node DOCS1" f.exec "decterm DOCS1 -lat"\n

# Vxt.xserver.keyboard.keymap: SWISS_FRENCH_LK401AK_DP
$ Vxt.xserver.pointer.shape: upperrightarrow
% Vxt.xserver.display.background: white
& Vxt.xserver.display.foreground: blue

Explanation:

! Sets the display language to French.

" Sets the terminal to autostart the Terminal Manager and VXT
Message Box, the local Motif window manager, and a VXT
DECterm window on node DOCS1 over the LAT transport.

# Sets the keyboard map to the LK401 (ANSI model) Swiss
French keyboard.

$ Sets the mouse pointer to the default arrow shape.

% Sets the screen background to white.

& Sets the screen foreground to blue.

2.2.2 Including
Resources
from Other
Resource Files

Resource files can call in other files. This feature allows you to
organize sets of resources in different files. For example, you may
create a resource file that contains your default settings for a
particular subset of resources. You could include this file in the
resource files for individual terminals.

There are two ways to call in another file:

• Use the #include command

• Use the Vxt.resource.resourceFile or the
Vxt.resource.groupFile: resources

#include Command An include command consists of a pound sign (#) followed by the
include command and a file name in quotes:

#include "file name"

For example:

#include "//tftp//nextfile-xrm"

See Section 2.5 for VXT file name conventions.
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Resources to Include
Files

You can use the following two resources to include other resource
files in the current resource file. Resource files can be nested up
to 20 levels.

• Vxt.resource.resourceFile: lets you include an individual
resource file. The resources in specified file override the same
resources in the current file or any group files.

• Vxt.resource.groupFile: lets you include a group resource
file. You can use this feature to include a file that contains
the default values for resources. These group values can be
overridden by any individual resource file.

If you use these resources to include a resource file, you can
specify a key within the composite file. See Section 2.5 for rules
about specifying file names. For example:

Vxt.resource.resourceFile: key keyname "//tftp//nextfile-xrm"

You cannot specify a key with the #include command.

Note

The terminal may ignore the settings in host-based
resource files if the resources are locked in the
configuration manager. See Chapter 3, Using the
Configuration Manager for details.

2.3 Creating Composite Resource Files

If you prefer, you can maintain the resources for different
terminals and work groups within a single resource file.

Key Name Syntax To mark the sections for individual terminal or work groups in
the file, you use key names. Use braces to enclose the list of
resources for that terminal or work group.

key keyname1
{
resource: value
.
.
.
}
key keyname2
{
resource: value
.
.
.
}

To access the correct resource key, the user includes the keyname

before the file name when specifying the resource file in the
Customize Resource Files dialog box (Section 2.4).
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If the key is for an individual terminal, the keyname can be the
terminal’s Internet address or Ethernet address. In this case,
the user can enter a substitution character for the address in the
Customize Resource Files dialog box.

2.4 Using Host-Based Resource Files

To activate a terminal resource file or group resource file for
a terminal, enter the file name in the terminal’s Customize
Resource Files dialog box. Then reset the terminal.

Displaying the
Customize Resource
Files Dialog Box

You can access the dialog box from the configuration manager or
from the individual terminal’s Terminal Manager window.

From the configuration manager: Choose the terminal you
want to customize. In the Customize Terminal dialog box, choose
Resource Files... from the Terminal Manager Customizations
scroll box. See Section 3.9, Customizing Work Groups and
Terminals .

From the individual terminal’s Terminal Manager window:

1. Click on the Customize menu.

2. Click on the Resource Files... menu item to display the
Customize Resource Files dialog box.

LJ−03533−RAGS

Specifying a
Resource File

1. In the Resource File box, click on the type of file you want to
enter – Terminal or Group.

2. In the Transport box, click on the transport you use—TFTP or
NFS.

3. For TFTP: Click on the Host box and enter the name or
address of the host where the resource file resides.

2–6 VXT Software: Managing Terminals and Work Groups



Using Host-Based Resource Files
2.4 Using Host-Based Resource Files

For NFS: Click on the Host box and enter an NFS mount
point. You must define mount points in the Customize NFS
dialog box.

4. Click on the Path box and enter the path to the file.

5. If you want to specify a key within the resource file, click on
the Key box and enter the key name.

6. Click on the " to add this information to the resource file you
selected.

7. Repeat these steps for each resource file—Terminal or Group.

8. Click on OK to save your setting and dismiss the dialog box.

To activate the new settings, you must reset the terminal:

1. In the Terminal Manager window, click on the Session menu.

2. Click on Reset.

Entering Resource
File Names Directly

You can also enter resource file names directly in the Terminal
or Group Resource File boxes. Use the syntax rules described in
Section 2.5.

To activate the new settings, reset the terminal from the Session
menu.

2.5 Specifying Resource Files

Use the following rules to specify file names in the Customize
Resource Files dialog box and in resource files. Use pathnames
relative to the TFTP or NFS root directory.

TFTP • If the file is on the same host used to boot the terminal, use
//tftp//path-to-file.

Note

For information on restricted TFTP access, see the VXT
system management chapter for your operating system in
this guide.

• If the file is on a different host, use //tftp/host/path-to-file.

NFS • Use //nfs/mount-name/path-to-file.

Specifying Keys from
Composite Resource
Files

To specify a key from a composite resource file (Section 2.3), enter
the key name:

key keyname or address path-to-composite-file

If you omit the path to the composite file, the terminal uses the
last composite file specified with any key. For example:

• In the Customize Resource Files dialog box, you can omit
the path for the terminal resource file if you have already
specified the same path for the group resource file. However,
you cannot omit the path for the group resource file.
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• If you are in a composite file, the terminal looks in that file.

• If no composite file has been specified, then the terminal uses
the default file name //tftp//vxtterminals.xrm.

Use Substitutions
for Addresses in
Resource File Names
and Key Names

If a resource file name or a key name includes the terminal’s
Ethernet address or Internet address, you can use the following
substitutions in place of the address when specifying the file or
key:

Use ... To represent... Address Example

#i The terminal’s Internet address 12.122.18.4

#e The terminal’s Ethernet address
(lowercase)

08002b28a744

#E The terminal’s Ethernet address
(uppercase)

08002B28A744

Examples The following table shows examples of specifying resource files
and key names.

To specify... Use...

Resource file
//tftp//vxt-08002628a744.xrm

//tftp//vxt-#e.xrm

Key name 08002628a744 in composite
resource file //tftp//vxtterminals.xrm

key #e vxt//tftp//vxtterminals.xrm

Key name 12.122.18.4 in the composite
resource file //tftp//vxtterminals.xrm

key #i vxt//tftp//vxtterminals.xrm

2.6 Scenarios

Here are four possible approaches for using host-based resource
files. You can use

• One host-based resource file for a terminal

• Two or more host-based resource files for a terminal

• Terminal resource files and a group resource file

• A composite resource file for all terminals

The following figures illustrate these approaches.

2–8 VXT Software: Managing Terminals and Work Groups



Using Host-Based Resource Files
2.6 Scenarios

One Host-Based
Resource File

Vxt.co

Vxt.co

Vxt.re

Host−Based
Resource Files

Vxt.xs

Vxt.re

Terminal Resource File

Vxt.xs

//TFTP/mynode/path−to−file/vxt−term1.xrm

Group Resource File

Your resource files should contain settings only for 

Customize Resource File Dialog Box 

mynode

vxt−term1.xrm

vxt−termn.xrm
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Terminal 1 Terminal 

. . .

(for Terminal 1):

.

.

.
the resources you want to customize.   

n

Two Host-Based
Resource Files

Terminal 1

#inclu

Vxt.co

Vxt.co

Vxt.re

Host−Based
Resource Files

Vxt.xs

Vxt.re
Vxt.xs

You can include one or more resource files
in another resource file. For example, you
might keep your VXT Create resources in
a separate file if you revise them frequently.

Terminal Resource File

//NFS/mountpoint/path−to−file/vxt−term1.xrm
Customized Resource Files Dialog Box

Group Resource File

vxt−term1.xrm

vxt−create.xrm

NFS 
mount point
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(for Terminal 1):
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Terminal Files and
Group Files

Terminal 2

#inclu

Vxt.co

Vxt.co

Vxt.re

Host−Based
Resource Files

Vxt.xs

Vxt.re

Terminal Resource File

Vxt.xs

//TFTP/mynode/path−to−file/vxt−term1.xrm

Group Resource File

Customize Resource File Dialog Box 

mynode

vxt−term1.xrm

vxt−group.xrm

//TFTP/mynode/path−to−file/vxt−group.xrm
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Terminal 1 Terminal n

(for Terminal 1): 

...

Use terminal files to
store customized 
settings for individual
terminals.

Use group files to 
store customized
settings shared by
a group of terminals.

Composite File

Host−Based

Terminal 2

Resource File

Key Term1

Key Group1

Key Term 

You can maintain resources for different terminals and work groups 
in one composite resource file. 

Terminal Resource File

key Group1 //NFS/mountpoint/path/vxt−comp.xrm

Group Resource File

vxt−comp.xrm

Customize Resource Files Dialog Box 

NFS
mount point

key Term1 //NFS/mountpoint/path/vxt−comp.xrm

LJ−03553−RAGS

(for Terminal 1): 

Terminal 1 Terminal 

{
Vxt.xserver.keybo
Vxt.xserver.pointe
}

{
Vxt.loadOptions.te
Vxt.loadOptions.m
}

{
Vxt.xserver.keybo
Vxt.xserver.pointe
}

...

n

n
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2.7 Displaying the List of Files in Use

To display the resource files in use for a terminal:

1. In the Terminal Manager window, click on the Session menu.

2. Click on Status to display the Status submenu.

3. Click on System Configuration... to display the System
Configuration dialog box.

4. Check the Resource files currently in use scroll box.

The scroll box lists all resource files in use, except files that
were included with the #include command.

2.8 Default Sequence for New Terminals

When you boot a new terminal that has not been customized yet,
the terminal looks for its resources in the following order:

1. Native resource file in the terminal’s NVRAM or on an
InfoServer system

2. //tftp//vxt/config/vxt#e.xrm host-based resource file on the
boot host

3. The key #e in the //tftp//vxt/config/vxtterminals.xrm

host-based resource file on the boot host

4. The key #i in the //tftp//vxt/config/vxtterminals.xrm

host-based resource file on the boot host

2.9 Adding Other Resources

Your host-based resource files can include resources for common
applications and local VXT applications that do not appear in
dialog boxes.

For example, you can include resources that point to the following
files:

• .mwmrc file for customizing the local Motif window manager.

• rgb.txt file for customizing display color definitions. You can
use this file to ensure that an application’s color display looks
the same on different types of monitors.

2.9.1 Using an
.mwmrc File for
the Window
Manager

VXT Version 2.1 software lets you use a remote .mwmrc file to
customize the terminal’s Motif window manager. When you start
the terminal’s Motif window manager, it reads the .mwmrc file.

You use the Mwm*configFile: resource to specify the path to the
file. You can use the TFTP or NFS transport for access.

See the Motif User’s Guide that comes with your system for
information about mwmrc.
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Specifying the
.mwmrc Path

Use the following syntax to specify the path to an .mwmrc file in a
host-based resource file:

Mwm*configFile: //transport/node-name/path-name/file-name

Example The following entry defines an NFS path to a file named .mwmrc in
directory /smith/usr/users on node pelican:

Mwm*configFile: //nfs/pelican/usr/usrs/smith/.mwmrc

Retaining the VXT
Create Pop-Up Menu

Normally, you can use mouse button 2 (MB2) to display the VXT
Create pop-up menu. This mouse button assignment is associated
with the terminal’s Motif window manager. If you use a remote
.mwmrc file, the file overrides the mouse button assignments for
the local Motif window manager. To retain access to the VXT
Create pop-up menu, you must include the following line in
DefaultButtonBindings list of the remote .mwmrc file:

<Btn2Down> root f.menu VxtCreateMenu

2.9.2 Using an
rgb.txt File for
Colors

The VXT Version 2.1 X11R5 server lets you use a remote rgb.txt

file that defines custom display colors. You can include only
one rgb.txt file. To include the file, you specify a path with the
Vxt*rgbfile: resource.

Specifying the rgb.txt
Path

Use the following syntax to specify the path to an rgb.txt file in a
host-based resource file:

Vxt*rgbfile://transport/node-name/path-name/file-name

Example The following entry defines a TFTP path to a file named
my_rgb.txt in directory /tftpboot/vxt/config on node pelican:

Vxt*rgbfile: //tftp/pelican/tftpboot/vxt/config/my_rgb.txt

rgb.txt File Syntax An rgb.txt file contains one line for each color definition:

Red-value Green-value Blue-value Color-name

Each color definition includes three decimal integer values for red,
green, and blue intensity. Each value is a decimal integer in the
range of 0 to 255. Spaces between the blue value and color name
are ignored, but the color name includes all other characters until
the end of line. If a color name includes more than one word,
separate the words with a single space.

VXT Clients Require
Black and White

Certain VXT local clients and other Digital X applications
rely on the color names white and black being defined in the
color database. If you are using a remote rgb.txt file, Digital
recommends that you include the following definitions:

0 0 0 black
255 255 255 white
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2.10 Resource Template File

The VXT Version 2.1 software installation kits for ULTRIX,
DEC OSF/1 AXP, and UNIX systems provide the following
vxtcfgtmpl.xrm template file:

!===============================================================================
! VXT Software Version 2.1 Resource File Template
!===============================================================================
! Copyright (c) 1993 by Digital Equipment Corporation, Maynard, Mass.
!
! This software is furnished under a license and may be used and copied
! only in accordance with the terms of such license and with the
! inclusion of the above copyright notice. This software or any other
! copies thereof may not be provided or otherwise made available to any
! other person. No title to and ownership of the software is hereby
! transferred.
!
! The information in this software is subject to change without notice
! and should not be construed as a commitment by Digital Equipment
! Corporation.
!
! Digital assumes no responsibility for the use or reliability of its
! software on equipment which is not supplied by Digital.
!===============================================================================
!Abstract:
! This file provides a template for creating a host-based resource file to
! control the customized settings on terminals running VXT software. For
! details, see the VXT Software Version 2.1 Installation and System Management
! guide.
!
! This file lists all VXT resources, with default values and possible
! values. The file also lists local Motif window manager (MWM) resources and
! DECterm resources. You can use this file as a template to create your own
! host-based resource file, or you can edit the file and use it as a host-based
! resource file.
!
! The file contains the following sections:
!
! I. Resource File Syntax
! II. Alphabetical listing of VXT Customize dialog boxes and their resources
! III. Alphabetical listing of Configuration Resource Management resources
! IV. VXT AutoStart and Create dialog box resources
! V. Alphabetical listing of DECterm resources
! VI. Alphabetical listing of MWM resources
!
! All the resources in this file are commented out using the "!" character.
! To enable a resource setting, remove the "!" comment character at the
! beginning of the line and provide a value for the resource.
!
!===============================================================================
!I. Resource File Syntax
!===============================================================================
!
! Resource names are case-sensitive. Resource values are not case-sensitive.
!
! Default: Default
!
! Boolean: enable disable
! On Off
! Yes No
! 1 0
! TRUE FALSE
!
! String: string string string string

VXT Software: Managing Terminals and Work Groups 2–13



Using Host-Based Resource Files
2.10 Resource Template File

! "string string string string"
!
! Integer: 100 (decimal)
! #10ABC (hex)
!
! Color: (color name)
! #rgb
! #rrggbb
! #rrrgggbbb (hexadecimal values)
!
! List of Values: value, value, value, ...
! value\n value\n value\n ...
!
! IP Host: <host name>
! n.n.n.n (dotted decimal notation)
!
! IP Route: <type> <destination address> <gateway address> <metric>
! <type> = {default, host, network}
!
! Mount Point: <IP host>:/<remote name> <mount point name>
!
! DECnet host: <node name>
! <node number>
! <area>.<number>
!
! Remote file specification:
! //tftp//<path to file>
! //tftp/<IP host>/<path to file>
! //nfs/<mount point name>/<path to file>
!
! Font path element: tcpip/<IP host>
! decnet/<DECnet host>
! //lastport
! //lastport//<font set name>
! //lastport/<server name>/<font set name>
! <remote file specification>
!
!
! To include another resource file, use:
! #include "<remote file specification>"
!
!
!===============================================================================
!II. VXT Terminal Manager Resources
!===============================================================================
!
!----------------------- Customize Boot Dialog Box ----------------------------
!
! Vxt.boot.primary.type:
! Default: auto Values: auto, ip, mop, moppreconfigured
!
! Vxt.boot.primary.file:
! Default: none Values: (string)
!
! Vxt.boot.system.version:
! Default: Default Values: (string)
!
! Vxt.comm.mop.trigger:
! Default: disable Values: (Boolean)
!
! Vxt.comm.mop.trigger.password:
! Default: "0" Values: (string)
!
!----------------------- Customize DECnet Dialog Box --------------------------
!
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! Vxt.comm.decnet:
! Default: disable Values: (Boolean)
!
! Vxt.comm.decnet.address:
! Default: none Values: (DECnet address)
!
! Vxt.comm.decnet.bufferSize:
! Default: 576 Values: (integer, 100 to 1478)
!
!--------------- Customize DECnet Name Translator Dialog Box ------------------
!
! Vxt.comm.decnet.nameTranslator:
! Default: none Values: n.n, n.n (decimal primary & secondary)
!
!----------------------- Customize Font Path Dialog Box -----------------------
!
! Vxt.xserver.fontPath:
! Default (for host-based systems): none
! Default (for server-based systems): //lastport
! Values: (list of Font Path elements)
!
!----------------------- Customize Keyboard Dialog Box ------------------------
!
! *blinkRate:
! Default: 500 milliseconds Values: (integer, 0 to 1000 milliseconds)
!
! *blinkEnable:
! Default: enable Values: Boolean
!
! Vxt.xserver.keyboard.keymap:
! Default: System Default Values: System Default, see the Keyboard Type
! scroll box listing)
!
! Vxt.xserver.keyboard.autoRepeat:
! Default: enable Values: Boolean
!
! Vxt.xserver.keyboard.bell:
! Default: enable Values: Boolean
!
! Vxt.xserver.keyboard.bellPercent:
! Default: 30 Values: (integer, 0 to 100)
!
! Vxt.xserver.keyboard.keyclick:
! Default: enable Values: Boolean
!
! Vxt.xserver.keyboard.keyclickPercent:
! Default: 30 Values: (integer, 0 to 100)
!
! Vxt.xserver.keyboard.lockMode:
! Default: caps Values: caps, shift
!
!----------------------- Customize Language Dialog Box ------------------------
!
! *xnlLanguage:
! Default: en_us Values: en_us, fr_fr, de_de, it_it, es_es, nl_nl, iw_il
!
!----------------------- Customize LASTport Dialog Box ------------------------
!
! Sorry, the Customize LASTport group code cannot be remotely customized.
!
!----------------------- Customize LAT Dialog Box -----------------------------
!
! Vxt.comm.lat.circuitTimer:
! Default: 30 Values: (integer, 10 to 1000) (milliseconds)
!
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! Vxt.comm.lat.retransmitLimit:
! Default: 40 Values: (integer, 4 to 120)
!
! Vxt.comm.lat.keepAlive:
! Default: 40 Values: (integer, 10 to 255) (seconds)
!
!----------------------- Customize NFS Dialog Box -----------------------------
!
! Vxt.comm.ip.nfs.mountPoints:
! Default: none Values: (list of Mount Points)
!
!----------------------- Customize Pointer Dialog Box -------------------------
!
! Vxt.xserver.pointer.acceleration:
! Default: medium Values: fast, medium, slow, none
!
! Vxt.xserver.pointer.background:
! Default: white Values: (color name or RGB)
!
! Vxt.xserver.pointer.foreground:
! Default: black Values: (color name or RGB)
!
! Vxt.xserver.pointer.buttonOrder:
! Default: right Values: right, left (handed)
!
! Vxt.xserver.pointer.shape:
! Default: upperleftarrow Values: upperleftarrow, plus, uparrow,
! upperrightarrow, leftarrow, rightarrow, x, circle, mouse, leftpointer,
! uppointer, rightpointer, check
!
! *multiClickTime:
! Default: 250 milliseconds Values: (integer, 0 to 2500 milliseconds)
!
!----------------------- Customize Print Screen Dialog Box --------------------
!
! Vxt.printScreen.aspectRatio:
! Default: 1 to 1 Values: 1 to 1, 2 to 1
!
! Vxt.printScreen.formFeed:
! Default: enable Values: (Boolean)
!
! Vxt.printScreen.ribbonSaver:
! Default: disable Values: (Boolean)
!
! Vxt.printScreen.colorMode:
! Default: monochrome Values: monochrome, color, dithered grayscale,
! dithered color, grayscale
! Vxt.printScreen.rotate:
! Default: disable Values: (Boolean)
!
! Vxt.printScreen.outputFormat:
! Default: sixels Values: sixels, postscript
!
! Vxt.printScreen.center:
! Default: disable Values: (Boolean)
!
!----------------------- Customize Resource Files Dialog Box ------------------
!
! Vxt.resource.resourceFile:
! Default: none Values: (Remote file specification)
! file <Remote file specification>
! key <key name> <Remote file specification>
!
! Vxt.resource.groupFile:
! Default: none Values: (Remote file specification)
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! file <Remote file specification>
! key <key name> <Remote file specification>
!
!----------------------- Customize Screen Background Dialog Box ---------------
!
! Vxt.xserver.display.background:
! Default: #356 Values: (color name or RGB)
!
! Vxt.xserver.display.foreground:
! Default: white Values: (color name or RGB)
!
! Vxt.xserver.display.pattern:
! Color Default: solid Values: weave, solid
! Monochrome Default: weave Values: weave, black, white
!
! Vxt.xserver.screenSaver:
! Default: enable Values: (Boolean)
!
! Vxt.xserver.screenSaver.interval:
! Default: 10 Values: (integer, 1 to 60 minutes)
!
! Vxt.xserver.os.rgbfile:
! Default: none Values: (Remote file specification)
!
!----------------------- Customize Security Dialog Box ------------------------
!
! Vxt.xserver.security.accessControl:
! Default: enable Values: (Boolean)
! This resource is for the Connections Allowed setting.
! The default setting of enable is the same as Listed Users Only.
! Using the disable value is the same as allowing All connections.
!
! Vxt.xserver.security.hostList:
! Default: none Values: <list of allowed hosts>
!
!------------- Customize Serial and Parallel Ports Box ------------------------
!
! Vxt.comm.serial.1.modemControl:
! Default: disable Values: (Boolean)
!
! Vxt.comm.serial.1.parityCheck:
! Default: enable Values: (Boolean)
!
! Vxt.comm.serial.1.charFormat:
! Default: 8n Values: 8n, 8e, 8o, 7n, 7e, 7o, 7m, 7s
!
! Vxt.comm.serial.1.stopBits:
! Default: 1 Values: 1, 2
!
! Vxt.comm.serial.1.XOFFat:
! Default: 64 Values: 0, 64, 128
!
! Vxt.comm.serial.1.usage:
! Default: host Values: host, printer, touchscreen
!
! Vxt.comm.serial.1.transmitRate:
! Default: 9600 Values: 300, 600, 1200, 2400, 4800, 9600, 19200, 38400
!
! Vxt.comm.serial.1.receiveRate:
! Default: 0 (receive = transmit) Values: 0, 300, 600, 1200, 2400, 4800, 9600, 19200, 38400
!
! Vxt.comm.printer.access:
! Default: enable Values: Boolean
!
!----------------------- Customize Software Options Dialog Box ----------------
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!
! Vxt.loadOptions.ex:
! Default: disable Values: (Boolean)
!
! Vxt.loadOptions.xie:
! Default: enable Values: (Boolean)
!
! Vxt.loadOptions.3270:
! Default: enable Values: (Boolean)
!
! Vxt.loadOptions.decterm:
! Default: enable Values: (Boolean)
!
! Vxt.loadOptions.fontmanager:
! Default: enable Values: (Boolean)
!
! Vxt.loadOptions.inforeader:
! Default: enable Values: (Boolean)
!
! Vxt.loadOptions.mwm:
! Default: enable Values: (Boolean)
!
! Vxt.loadOptions.printScreen:
! Default: enable Values: (Boolean)
!
! Vxt.loadOptions.netPrint:
! Default: enable Values: (Boolean)
!
! Vxt.loadOptions.terminalManager:
! Default: enable Values: (Boolean)
!
! Vxt.loadOptions.messageBox:
! Default: enable Values: (Boolean)
!
!----------------------- Customize TCP/IP Dialog Box --------------------------
!
! Vxt.comm.ip:
! Default: enable Values: (Boolean)
!
! Vxt.comm.ip.address:
! Default: none Values: (Ip Address)
!
! Vxt.comm.ip.subnetMask:
! Default: none Values: n.n.n.n (decimal IP notation)
!
!---------------- Customize TCP/IP Name Server Dialog Box ---------------------
!
! Vxt.comm.ip.domainName:
! Default: none Values: (string)
!
! Vxt.comm.ip.nameServer:
! Default: none Values: n.n.n.n, n.n.n.n (decimal IP notation,
! primary & secondary)
!
! Vxt.comm.ip.determineDomain:
! Default: disable Values: (Boolean)
!
!---------------- Customize TCP/IP Routing Tables Dialog Box ------------------
!
! Vxt.comm.ip.rip:
! Default: enable Values: (Boolean)
! This resource is for the Dynamic Routing button.
! The default setting of enable indicates Dynamic Routing enabled.
!
! Vxt.comm.ip.routes:
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! Default: none Values: (list of IP routes)
!
!------------------- Customize Terminal Manager Window ------------------------
!
! Vxt.create.allowRemoteWM:
! Default: disable Values: Boolean
!
! Vxt.terminalManager.pausePrompt:
! Default: Enter Password to Resume Values: (string)
!
! Vxt.terminalManager.confirmReset:
! Default: enable Values: Boolean
!
! Vxt.terminalManager.confirmClose:
! Default: enable Values: Boolean
!
! Vxt.terminalManager.tag:
! Default: none Values: (string)
!
! Vxt.terminalManager.initialState:
! Default: normal Values: icon, normal, hidden
! This resource is for the Startup State selection.
!
! Vxt.terminalManager.statusInterval:
! Default: 5 Values: (1 to 60 seconds)
! This resource is for the Status Update Frequency slide bar.
!
! Vxt.terminalManager.hideKey:
! Default: enable Values: (Boolean)
! This resource is for the Disable F3 Key button.
!
!----------- Customize Terminal Manager Window Position and Size --------------
!
! Vxt.terminalManager.x:
! Default: 11 Values: (integer)
!
! Vxt.terminalManager.y:
! Default: 27 Values: (integer)
!
! Vxt.terminalManager.width:
! Default: 779 Values: (integer)
!
! Vxt.terminalManager.height:
! Default: 145 Values: (integer)
!
!-------------------- Customize VXT Message Box Dialog Box --------------------
!
! Vxt.messageBox.headerText:
! Default: Messages Values: (string)
!
! Vxt.messageBox.messageType:
! Default: all Values: all, info, warn, error
!
! Vxt.messageBox.savedLines:
! Default: 50 Values: (integer, 10 to 200)
!
!--------------- Customize VXT Message Box Position and Size ------------------
!
! Vxt.messageBox.x:
! Default: 11 Values: (integer)
!
! Vxt.messageBox.y:
! Default: 210 Values: (integer)
!
! Vxt.messageBox.width:
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! Default: 779 Values: (integer)
!
! Vxt.messageBox.height:
! Default: 300 Values: (integer)
!
!----------------------- Customize TouchScreen Dialog Box ---------------------
!
! TOUCHplus.type:
! Default: Capacitive Values: Capacitive, Resistive 1, Resistive 2, Saw,
! DECtouch
!
! TOUCHplus.calibrationPoints:
! Default: 5 Values: (integer)
!
! TOUCHplus.audibleTouch:
! Default: disable Values: (Boolean)
!
! TOUCHplus.xCalibration:
! Default: 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0,
! 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0
! Values: (list of integer)
!
! TOUCHplus.yCalibration:
! Default: 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0,
! 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0
! Values: (list of integer)
!
! TOUCHplus.jitter:
! Default: 2 Values: (list of integer)
!
! TOUCHplus.pressOnTouchdown:
! Default: TRUE Values: (Boolean)
!
! TOUCHplus.releaseOntouchdown:
! Default: TRUE Values: (Boolean)
!
! TOUCHplus.pressOnLiftoff:
! Default: FALSE Values: (Boolean)
!
! TOUCHplus.releaseOnLiftoff:
! Default: FALSE Values: (Boolean)
!
! TOUCHplus.activate:
! Default: FALSE Values: (Boolean)
!
!----------------------- Customize Window Colors Dialog Box --------------------
!
! *Background:
! Color default: CACAAAAA9191
! Monochrome default: BLACK
! Values: (color name or RGB)
!
! *Foreground:
! Color default: BLACK
! Monochrome default: WHITE
! Values: (color name or RGB)
!
! *highlightColor
! Color default: BLACK
! Monochrome default: BLACK
! Values: (color name or RGB)
!
! *autoshade:
! Color default: ENABLE
! Monochrome default: ENABLE
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! Values: (color name or RGB)
!
! *topShadowColor:
! Color default: DCDCBCBCA3A3
! Monochrome default: DCDCBCBCA3A3
! Values: (color name or RGB)
!
! *bottomShadowColor:
! Color default: BLACK
! Monochrome default: 989878786767
! Values: (color name or RGB)
!
!----------------------- Customize X Server Dialog Box ------------------------
!
! Vxt.xserver.backingStore:
! Default: enable Values: Boolean
!
! Vxt.xserver.monitor:
! Default: color Values: color, greyscale
!
! Vxt.xserver.resetServerAction:
! Default: restart Values: restart, reboot, ignore
!
! Vxt.xserver.displayScaling:
! Default: 100 Values: (integer, one of 100, 75, 133) (percent)
!
!===============================================================================
! III. Configuration Resource Management Dialog Box
!===============================================================================
!
! Vxt.resource.lock.keyboard:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.language:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.pointer:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.printScreen:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.security:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.display:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.xclient:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.terminalManager:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.messageBox:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.autoStart:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.serial:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.lat:
! Default: disable Values: (Boolean)
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!
! Vxt.resource.lock.lastport:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.ip:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.ipNames:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.ipRoutes:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.nfs:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.decnet:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.decnetNames:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.configuration:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.fontpath:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.xserver:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.boot:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.loadOptions:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.resourceFiles:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.touchScreen:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.create:
! Default: disable Values: (Boolean)
!
! Vxt.resource.lock.decterm:
! Default: disable Values: (Boolean)
!
!===============================================================================
! IV. VXT AutoStart and Create Dialog Box Resources
!===============================================================================
!----------------------- Customize AutoStart Dialog Box -----------------------
!
! Vxt.create.autoStart:
! Defaults:
! "Term Mgr + Msg Box" f.exec "term_mgr -msgbox"\n\
! "Motif WM" f.exec "mwm"\n
!
! Values: See the Create dialog box description for syntax and a list
! of local VXT application names.
!
! Note: You cannot AutoStart remote applications.
!
!----------------------- Create Dialog Box ------------------------------------
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!
! Vxt.create.createList:
! Defaults:
! "VXT Create" f.title\n\
! "Term Mgr + Msg Box" f.exec "term_mgr -msgbox"\n\
! "Motif WM" f.exec "mwm"\n
!
! A backslash (\) at the end of a line indicates there are more
! applications in the list. The last listed item does not have a final
! backslash.
!
! Values: You can create local VXT applications or remote host applications.
! See the following description.
!
! Local VXT Applications
! ----------------------
!
! Syntax:
!
! "<comment>" f.exec "<application name> <arguments>"
!
!_____________________________________________________________________________
! Application Name Arguments
!-----------------------------------------------------------------------------
! x [-ip, -ip -indirect, -lat, or -dnet] <host>
! decterm [-ip, -ip -indirect, -lat, or -dnet] <host>
! decterm -serial
! mwm none
! term_mgr [-msgbox]
! msgbox none
! font_mgr none
! 3270 [-dnet]
!-----------------------------------------------------------------------------
! <> indicates a required argument.
! [] indicates an optional argument. Choices are separated by commas.
!
! IP is the default transport for DECterm and X applications.
! DECnet is the default transport for the 3270 application.
!
! Examples:
!______________________________________________________________________________
! To Create... Use...
!______________________________________________________________________________
! TCP/IP X session on host Art x -ip art
! LAT X session on host Art x -lat art
! DECnet X session on host Art x -dnet art
! TCP/IP DECterm window on host Art decterm -ip art
! LAT DECterm window on host Art -lat art
! DECnet DECterm window on host Art -dnet art
! Serial DECterm window decterm -serial
! Local Motif window manager mwm
! Terminal Manager window term_mgr
! Terminal Manager window and VXT Message Box term_mgr -msgbox
! VXT Message Box msgbox
! Font manager font_mgr
! DECnet VXT 3270 terminal window 3270 -dnet
!______________________________________________________________________________
! Note: Comments entered and saved in the Create dialog box will overwrite
! comments for the same application in the host-based resource file.
!
!
! Remote Host Applications
!
! Syntax:
!
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! "<comment>" f.exec "rexec <vxt_launcher> <command>"
!
! Example: This example shows a remote clock application added to the
! end of the default create list.
!
! Vxt.create.createList:
! "VXT Create" f.title\n\
! "Term Mgr + Msg Box" f.exec "term_mgr -msgbox"\n\
! "Motif WM" f.exec "mwm"\n\
! "Start the clock" f.exec "rexec vxt run sys$system:decw$clock"\n
!
!===============================================================================
! V. VXT DECterm Application Resources (default values listed)
!===============================================================================
!
! DECterm.allowShellResize: on
! DECterm.ancestorSensitive: on
! DECterm.argc: 0
! DECterm.background: #cacaaaaa9191
! DECterm.borderColor: #000000000000
! DECterm.depth: 8
! DECterm.iconName: VXT DECterm
! DECterm.iconic: off
! DECterm.main.terminal.CRM: off
! DECterm.main.terminal.adjustFontSizes: on
! DECterm.main.terminal.ancestorSensitive: on
! DECterm.main.terminal.angleBracketsKey: 0
! DECterm.main.terminal.answerbackMessage:
! DECterm.main.terminal.applicationCursorKeyMode: off
! DECterm.main.terminal.applicationKeypadMode: off
! DECterm.main.terminal.autoAdjustPosition: on
! DECterm.main.terminal.autoRepeatEnable: on
! DECterm.main.terminal.autoResizeTerminal: off
! DECterm.main.terminal.autoResizeWindow: on
! DECterm.main.terminal.autoWrapEnable: off
! DECterm.main.terminal.backarrowKey: 1
! DECterm.main.terminal.background: #cacaaaaa9191
! DECterm.main.terminal.backingStoreEnable: on
! DECterm.main.terminal.batchScrollCount: 0
! DECterm.main.terminal.bigFontOtherName:
! DECterm.main.terminal.bigFontSetName: -*-Terminal-*-*-*--*-180-*-*-*-*-*-*
! DECterm.main.terminal.bigFontSetSelection: off
! DECterm.main.terminal.bitPlanes: 0
! DECterm.main.terminal.borderColor: #000000000000
! DECterm.main.terminal.borderWidth: 0
! DECterm.main.terminal.columns: 80
! DECterm.main.terminal.concealAnswerback: off
! DECterm.main.terminal.condensedFont: off
! DECterm.main.terminal.controlQSHold: on
! DECterm.main.terminal.couplingHorizontal: off
! DECterm.main.terminal.couplingVertical: on
! DECterm.main.terminal.cursorBlinkEnable: on
! DECterm.main.terminal.cursorStyle: 0
! DECterm.main.terminal.depth: 8
! DECterm.main.terminal.disableXSME: off
! DECterm.main.terminal.displayHeight: 488
! DECterm.main.terminal.displayHeightInc: 20
! DECterm.main.terminal.displayWidth: 907
! DECterm.main.terminal.displayWidthInc: 11
! DECterm.main.terminal.doubleClickDelay: 250
! DECterm.main.terminal.eightBitCharacters: on
! DECterm.main.terminal.fineFontSetName:
! -JDECW-Screen-Medium-R-Normal--14-*-*-*-*-*-*-*
! DECterm.main.terminal.fontSetSelection: 1
! DECterm.main.terminal.fontUsed:
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! -bitstream-terminal-medium-r-normal--18-140-100-100-c-110-iso8859-1
! DECterm.main.terminal.foreground: #000000000000
! DECterm.main.terminal.graphicsPrintingEnabled: on
! DECterm.main.terminal.gsFontOtherName:
! DECterm.main.terminal.gsFontSetName: -*-Terminal-*-*-*-GS-*-140-*-*-*-*-*-*
! DECterm.main.terminal.gsFontSetSelection: off
! DECterm.main.terminal.height: 488
! DECterm.main.terminal.jisRomanAsciiMode: 0
! DECterm.main.terminal.kanjiKatakanaMode: 0
! DECterm.main.terminal.kanji_78_83: 1
! DECterm.main.terminal.keyboardDialect: 0
! DECterm.main.terminal.ksRomanAsciiMode: 0
! DECterm.main.terminal.leadingCodeEnable: on
! DECterm.main.terminal.littleFontOtherName:
! DECterm.main.terminal.littleFontSetName:-*-Terminal-*-*-*--*-140-*-*-*-*-*-*
! DECterm.main.terminal.littleFontSetSelection: off
! DECterm.main.terminal.localEcho: off
! DECterm.main.terminal.lockUDK: off
! DECterm.main.terminal.lockUserFeatures: off
! DECterm.main.terminal.macrographReportEnable: off
! DECterm.main.terminal.mappedWhenManaged: on
! DECterm.main.terminal.marginBellEnable: off
! DECterm.main.terminal.maxInput: 256
! DECterm.main.terminal.newLineMode: off
! DECterm.main.terminal.openQuoteTildeKey: 0
! DECterm.main.terminal.periodCommaKeys: 0
! DECterm.main.terminal.printBackgroundMode: on
! DECterm.main.terminal.printColorMode: on
! DECterm.main.terminal.printDataType: 2
! DECterm.main.terminal.printDisplayMode: 1
! DECterm.main.terminal.printExtent: 0
! DECterm.main.terminal.printFormFeedMode: on
! DECterm.main.terminal.printFormat: 0
! DECterm.main.terminal.printHLSColorSyntax: on
! DECterm.main.terminal.printMode: 0
! DECterm.main.terminal.printSixelLevel: 1
! DECterm.main.terminal.printerFileName:
! DECterm.main.terminal.printerPending: 0
! DECterm.main.terminal.printerPortName:
! DECterm.main.terminal.printerStatus: 13
! DECterm.main.terminal.printerToHostEnabled: off
! DECterm.main.terminal.printingDestination: 3
! DECterm.main.terminal.redisplay7bit: off
! DECterm.main.terminal.regisScreenMode: off
! DECterm.main.terminal.responseDA: 8
! DECterm.main.terminal.reverseVideo: off
! DECterm.main.terminal.rightToLeft: off
! DECterm.main.terminal.rows: 24
! DECterm.main.terminal.saveErasedLines: on
! DECterm.main.terminal.saveLinesOffTop: on
! DECterm.main.terminal.screenMode: on
! DECterm.main.terminal.scrollHorizontal: off
! DECterm.main.terminal.scrollVertical: on
! DECterm.main.terminal.selectThreshold: 5
! DECterm.main.terminal.selectionRtoL: off
! DECterm.main.terminal.sensitive: on
! DECterm.main.terminal.shareColormapEntries: off
! DECterm.main.terminal.statusDisplayEnable: off
! DECterm.main.terminal.syncFrequency: 10
! DECterm.main.terminal.terminalDriverResize: on
! DECterm.main.terminal.terminalMode: 2
! DECterm.main.terminal.terminalType: 0
! DECterm.main.terminal.textCursorEnable: on
! DECterm.main.terminal.transcriptSize: 500
! DECterm.main.terminal.useBoldFont: on
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! DECterm.main.terminal.userPreferenceSet: 0
! DECterm.main.terminal.warningBellEnable: on
! DECterm.main.terminal.whiteSpaceCharacters: \ \015\n
! DECterm.main.terminal.width: 907
! DECterm.main.terminal.x: 0
! DECterm.main.terminal.y: 0
! DECterm.mappedWhenManaged: on
! DECterm.overrideRedirect: off
! DECterm.saveUnder: off
! DECterm.sensitive: on
! DECterm.title: VXT DECterm
! DECterm.transient: off
! DECterm.waitforwm: on
! DECterm.winGravity: -1
! DECterm.wmTimeout: 5000
!
!===============================================================================
! VI. VXT Motif Window Manager Resources (default values listed)
!===============================================================================
!
! Mwm*activeAutoShade: True
! Mwm*activeBackground: #9851785167AD
! Mwm*activeBackgroundPixmap: unspecified_pixmap
! Mwm*activeBottomShadowColor: #529737652849
! Mwm*activeBottomShadowPixmap: unspecified_pixmap
! Mwm*activeForeground: #000000000000
! Mwm*activeTopShadowColor: #AF4199C18E2E
! Mwm*activeTopShadowPixmap: unspecified_pixmap
! Mwm*autoKeyFocus: True
! Mwm*autoShade: True
! Mwm*background: #CA94AA469193
! Mwm*backgroundPixmap: unspecified_pixmap
! Mwm*bottomShadowColor: #9851785167AD
! Mwm*bottomShadowPixmap: unspecified_pixmap
! Mwm*buttonBindings: DefaultButtonBindings
! Mwm*cancelLabelString: \ Cancel
! Mwm*clientDecoration: all
! Mwm*deiconifyKeyFocus: True
! Mwm*fadeNormalIcon: True
! Mwm*focusAutoRaise: True
! Mwm*fontList: -*-Helvetica-Bold-R-Normal--*-120-*-*-*-*-ISO8859-1
! Mwm*forceAltSpace: False
! Mwm*foreground: #000000000000
! Mwm*freezeOnConfig: True
!
! Mwm*iconAutoPlace: True
! Mwm*iconBoxGeometry: 14x1+0+2000
! Mwm*iconBoxSBDisplayPolicy: vertical
! Mwm*iconBoxTitle: Icon Box
! Mwm*iconDecoration: activelabel label image
! Mwm*iconImageAutoShade: True
! Mwm*iconImageBackground: #CA94AA469193
! Mwm*iconImageBackgroundPixmap: unspecified_pixmap
! Mwm*iconImageBottomShadowColor: #8A8A73736363
! Mwm*iconImageBottomShadowPixmap:unspecified_pixmap
! Mwm*iconImageForeground: #000000000000
! Mwm*iconImageTopShadowColor: #DC28BC3DA3D6
! Mwm*iconImageTopShadowPixmap: unspecified_pixmap
! Mwm*iconPlacement: Bottom Right
! Mwm*iconPlacementMargin: 1
! Mwm*iconbox*windowMenu: IconBoxMenu
! Mwm*keyBindings: DefaultKeyBindings
! Mwm*keyboardFocusPolicy: explicit
! Mwm*matchMenuColors: 1
! Mwm*matteAutoShade: True
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! Mwm*matteBackground: #CA94AA469193
! Mwm*matteBottomShadowColor: #8A8A73736363
! Mwm*matteBottomShadowPixmap: unspecified_pixmap
! Mwm*matteForeground: #000000000000
! Mwm*matteTopShadowColor: #DC28BC3DA3D6
! Mwm*matteTopShadowPixmap: unspecified_pixmap
! Mwm*matteWidth: 0
! Mwm*menu*background: #9851785167AD
! Mwm*menu*backgroundPixmap: unspecified_pixmap
! Mwm*menu*bottomShadowColor: #529737652849
! Mwm*menu*bottomShadowPixmap: unspecified_pixmap
! Mwm*menu*foreground: #000000000000
! Mwm*menu*topShadowColor: #AF4199C18E2E
! Mwm*menu*topShadowpixmap: unspecified_pixmap
! Mwm*okLabelString: \ OK
! Mwm*raiseKeyFocus: True
! Mwm*resizeBorderWidth: 10
! Mwm*restartSettings: True
! Mwm*startupKeyFocus: True
! Mwm*systemButtonClick2: False
! Mwm*systemButtonClick: True
! Mwm*systemMenu: RootMenu
! Mwm*topShadowColor: #DC28BC3DA3D6
! Mwm*topShadowPixmap: unspecified_pixmap
! Mwm*transientDecoration: Title resize
! Mwm*useDECMode: True
! Mwm*useIconBox: False
! Mwm*wMenuButtonClick2: False
! Mwm*windowMenu: DefaultWindowMenu
! Mwm*workspaceMenu: True
!
!====================== End of Resource File Template =========================
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3
Using the Configuration Manager

Chapter Overview This chapter describes how to use the configuration manager on
any VXT 2000 windowing terminal to centrally manage other
VXT 2000 windowing terminals. You can configure groups of
terminals to share settings. Shared settings apply to the terminal
manager, window manager, and VXT DECterm windows. If you
have an InfoServer system, you can also create and manage font
sets that terminals share.

Host-Based or
Server-Based
Operation

For server-based terminals, you can use all features of the
configuration manager. Server-based terminals store their
customizations on an InfoServer system. You can customize
and manage individual terminals or work groups. You can
move terminals, work groups, and font sets among servers. See
Section 3.1.

For host-based terminals, you can customize individual
terminals from the configuration manager. Host-based terminals
store their customizations locally in the terminal’s nonvolatile
memory. See Section 3.2.

New Features Customize DECnet, LASTport, and Boot Settings

The configuration manager in VXT Version 2.1 software lets you
customize three features you previously could customize only from
individual terminals:

• DECnet address

• LASTport group code (for server-based terminals)

• Primary boot settings (for loading VXT software)

See Section 3.10.1.

Options Menu

The Resource Management dialog box contains a new Options
menu (Section 3.3). From this menu, you can synchronize
settings in a terminal’s NVRAM memory with the settings in the
terminal and work group resource files. You must use this feature
before customizing DECnet, LASTport, or primary boot settings
(Section 3.10.1).

Note

Use a terminal running VXT Version 2.1 software to
manage terminals running Version 2.1 software.
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3.1 Getting Started—Managing Server-Based Terminals

This section describes some reasons for using terminal work
groups and introduces some basic concepts.

3.1.1 Work
Group
Management

The configuration manager lets you view a list of support servers,
work groups, and terminals on your network, by group code.
You can create, customize, copy, back up, move, and delete
configurations of work groups and terminals on servers within
the same group code. To perform these functions, you use the
Configuration Manager: Resource Management dialog box. The
following table describes some reasons for placing terminals in
work groups:

Purpose Description

Customize more than one
terminal at a time.

You can quickly customize a work group to share the same customized
settings. For example, if a group of terminals run applications requiring
special fonts, you can customize their work group to use a font path to a
particular InfoServer system that has those fonts.

Limit the types of
customizations terminals
can perform.

You can use a work group to restrict changes to terminal customizations.
For example, you could choose the system image version used by a group of
terminals, then lock the setting to prevent terminals from changing it.

Balance the resource
load for terminals across
InfoServer systems.

You can choose which InfoServer system stores a terminal’s resource file and
work group. The terminal uses system resources based on this choice. The
terminal

• Reads and writes its customizations to that InfoServer system

• Pages in its VXT system image from that InfoServer system

• Uses that InfoServer disk for virtual memory

3.1.2 Introducing
Some Terms

Before you start to configure server-based terminals, you should
become familiar with the following terms:

LASTport Group
Code

You assign an InfoServer system to a group by using a LASTport
group code. The default group code setting is 0. The InfoServer
system communicates only with systems assigned to the same
group code. You can assign only one group code to an InfoServer
system, in the range of 0 to 1023. To change the group code of an
InfoServer system, log in to the InfoServer system and use the
SET SERVER LASTPORT GROUP command. For example:

InfoServer> SET [SERVER] LASTPORT [GROUP] 20
InfoServer> SAVE

LASTport work groups provide a method of segmenting local area
networks (LANs) so that services offered by an InfoServer system
on one LAN segment are not seen by clients on another segment.
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Native Resource File Each server-based terminal stores its customized settings in its
native resource file on a particular InfoServer system. The file
is uniquely identified by the terminal’s Ethernet physical address.
The customized settings apply to the terminal manager, window
manager, and VXT DECterm windows. You access the settings
through the configuration manager or the individual terminal’s
dialog boxes.

Work Group A work group is a native resource file and a set of terminals
that share the file. Each work group is assigned to a particular
InfoServer system. A newly installed InfoServer system comes
with one work group, called the Unregistered Terminals work
group (Section 3.1.3).

When you create a work group, you assign a password to the work
group. The password lets you control access to the work group’s
customization file from the resource management dialog boxes.
You can change work group passwords.

Read-Only Terminal A read-only terminal belongs to a work group that does not
allow terminals to save customized settings, such as the default
Unregistered Terminals work group. If you start up terminals
under the default Unregistered Terminals work group, you should
register (create) them in another established work group as soon
as possible.

You can turn off the read-only feature of the Unregistered
Terminals work group, to allow terminals to save customized
settings. In this way, you do not have to create each terminal
manually. You can move the unregistered terminals to a
registered work group at your convenience.

VXT manager
password

You need the VXT manager password to perform many
configuration manager operations. The VXT manager password is
assigned during the installation of the VXT software. You cannot
change the VXT manager password from the terminal. See the
InfoServer chapters in this guide for details on changing the
password.

Default VXT manager password: VXT.

3.1.3 Unregistered
Terminals Work
Group

A newly installed InfoServer system comes with one work group
already created, called the Unregistered Terminals work
group. The purpose of the Unregistered Terminals work group is
to let terminals operate until they are registered (created) in an
established work group.
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Default: Read-Only
Settings

The Unregistered Terminals work group is preconfigured with
factory-default settings that are read-only. By default, terminals
that join this work group cannot save new customizations or
create their own terminal customization files; they can only read
the default settings of the work group. You can customize the
work group so that it allows terminals to read and write settings
(Section 3.9). This decision depends on how much control you
want to exercise in managing terminals.

When you start up an unregistered terminal, the terminal seeks
out InfoServer systems with the same LASTport group code. For
VXT Version 1.1 software and later, the terminal first looks for an
Unregistered Terminals work group that is also a read/write work
group. If no such work group is found, the terminal joins the first
Unregistered Terminals work group found.

Option 1: You
Customize Each
Terminal

• If you want to control what terminals consume resources on an
InfoServer system, use the Configuration Manager: Resource
Management dialog box to manually create each terminal
in a work group on that InfoServer system. This might be
considered tedious, but the advantage is that terminals come
out of the box already customized to the site requirements
defined by a work group manager.

Option 2: Users
Customize Their
Terminal

• If you remove the read-only restriction of the Unregistered
Terminals work group file, any terminal that does not belong
to a work group can potentially bind to this service, save
customizations, and create its terminal resource file.

One advantage is that a large number of terminals
can be customized out of the box, without having to
create the terminals from a central location using the
Configuration Manager: Resource Management dialog box.
One disadvantage is that any terminal can potentially
consume resources on any InfoServer system that contains
a read/write Unregistered Terminals work group.

3.1.4 Backing
Up Work
Groups and
Terminals

You can back up your work group and terminal resource files. If
you back up a work group, you can also back up all the terminals
belonging to that work group. Backing up work group and
terminal resource files provides the following advantages:

• You have copies of your resource files if a disk failure occurs.

• You can preserve your terminal environment if the terminal’s
primary InfoServer system is unavailable when booting the
terminal.

Backup copies of work group and terminal resource files receive
a lower service rating than the original copies. The VXT loader
chooses the highest rated work group and terminal resource files.
If both the original and backup files are available, the VXT loader
chooses the original files since they have a higher rating.
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Note

This feature is present in VXT loader Version 1.1 and later.
If you want to take advantage of the backup feature, you
must use VXT loader Version 1.1 or later.

You can create as many backup copies of work group and terminal
resource files as you want, but you are responsible for maintaining
consistency between your primary and backup files.

When you display backup terminal or work group names in the
Configuration Manager: Resource Management dialog box, a
backup icon (Section 3.3) appears next to the normal terminal or
work group icon. This allows you to differentiate between primary
and backup terminal and work group files.

3.1.5 Work
Group Policies

Here are some current policies to consider when creating
terminals and work groups:

• The Unregistered Terminals work group is read-only by
default.

Other work groups are read/write by default.

• Primary terminal customization files can only exist in one
work group at a time.

• A terminal first tries to boot from the InfoServer system where
it obtained its customizations.

• A terminal using a VXT server-based image cannot save
customizations if

It does not have a terminal customization file and joins a
read-only Unregistered Terminals work group

Its work group disallows saving customizations

Its work group is not found on the InfoServer system where
the terminal customization file was found

• A terminal use the InfoServer system where it obtained its
customizations for paging services. If a terminal does not
have customizations, it pages to the InfoServer system that
downloaded the terminal’s image.

3.1.6 What Do I
Do First?

Read the sections on creating and deleting work groups and
terminals. Then:

1. Create a work group. If you have color terminals and
monochrome terminals, Digital recommends that you create a
separate work group for each.

2. Create all other terminals in your work group before you start
the terminals.
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Always try to create terminals in a work group before you start
them up. When you turn on a registered terminal, it becomes a
member of the registered work group that can save customized
settings.

If you start up a terminal before creating it in a work group,
the terminal joins the Unregistered Terminals work group as a
read-only terminal.

3.2 Getting Started—Managing Host-Based Terminals

Host-based terminals store their settings locally in the terminal’s
nonvolatile memory (NVRAM) rather than on an InfoServer
system. You can use the configuration manager to write settings
directly to any host-based terminal’s memory. Your changes take
effect when you reboot the terminals that you have customized.

Note

To manage host-based terminals from the configuration
manager, you need VXT Version 2.0 or later software.

3.2.1 Introducing
Some Terms

Before you start to configure host-based terminals, you should
become familiar with the following terms:

Local Terminals
Server and Local
Work Group

The configuration manager lists server-based terminals by their
server and work group. Host-based terminals do not have a
server and do not belong to work groups, so they are listed
under a Local Terminals server and Local work group. The Local
Terminals server and Local work group are labels provided for
convenience; they do not actually exist. You cannot perform work
group operations for host-based terminals.

After you boot a host-based terminal in a LAN, you can find it
listed by its Ethernet address under the Local Terminals server
and Local work group.

The Terminal Manager window’s System Configuration box
(Session menu) will list the terminal’s work group name as Local.
System messages displayed in the Message Box will also refer to
the Local work group.

NVR-Based Terminals Host-based terminals are also known as NVRAM-based or NVR-
based terminals, because they store their customizations in their
nonvolatile memory. You will see the term NVR based terminals in
some configuration manager dialog boxes.
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Terminal password You need a terminal password to perform many configuration
manager operations for a host-based terminal. A default password
is assigned to the NVR-based terminal resource file when the
terminal boots. This password is the default password for each
terminal in the Local work group. You can change this password
for individual terminals from the configuration manager.

Default password: VXTNVR.

If you forget a terminal’s password, you can reset it to VXTNVR
as follows:

1. Quickly press the halt button on the rear of the terminal. The
terminal displays the >>> prompt.

2. Enter the following BOOT command:

>>> B/200000

The terminal reboots its VXT software and resets the terminal
password to VXTNVR.

3.2.2 What
Functions Can
I Perform?

The following configuration manager functions are supported with
host-based terminals:

• Customizing a local terminal

• Copying customizations from a local terminal and to a local
terminal

• Backing up a local terminal to an InfoServer system

• Changing the password of a local terminal
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3.3 Displaying the Resource Management Dialog Box

To manage terminals and work groups, you use the Configuration
Manager: Resource Management dialog box. To display this
dialog box, pull down the Customize menu in the Terminal
Manager window. Choose the Configuration... menu item. From
the Configuration submenu, choose the Resource Management...
menu item. The Resource Management dialog box looks like this:
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Resource Scroll Box The scroll box lets you view the list of known servers, work
groups, and terminals by group code and select them for
management. All host-based terminals are listed under the
Local Terminals work group. Servers, work groups, and terminals
are listed in a hierarchy:

When you open the dialog box, the scroll box lists only known
servers. You can click MB3 on a server to display its work groups.
After you display work groups, you can click MB3 on a work
group to display its terminals. You can also double click MB1 on
the server or work group, instead of using MB3.

The File menu lets you

• Update the list of available servers for the currently selected
group code. When you choose Update Known Servers, the
scroll box in the Resource Management dialog box is updated
to list the available servers currently seen on the network.

• Display dialog boxes to find a terminal or a work group.

• Close the Resource Management dialog box.

The Create menu lets you display dialog boxes to create a work
group or terminal for management.
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The Maintenance menu lets you display dialog boxes to customize,
copy, back up, or delete the customized settings of work groups
and terminals.

You can also move terminals from one work group to another and
change work group passwords.

The Options menu lets you

• Specify the LASTport group code of the InfoServers that
support the terminals you want to manage. When you enter a
code, the Resource Management dialog box displays the list of
InfoServers that use that code.

• Synchronize the settings in the resource file and the settings
in the terminal’s NVRAM. You can synchronize settings at the
terminal or work group level.

• Save your option settings for future sessions.

Customize, Copy,
Move, Backup, and
Delete Buttons

These buttons display the dialog boxes for customizing, copying,
moving, backing up, or deleting work groups and terminals. You
can also choose these functions from the Maintenance menu.

3.3.1 Entering
Names,
Passwords,
and Addresses

When you enter names, passwords, and addresses in dialog boxes,
the configuration manager checks their syntax.

Item Syntax

Work group names Can contain 1 to 31 characters. Valid characters for work
group names are a to z, A to Z, 0 to 9, $, - (hyphen),
. (period), and the characters in columns 12 to 15 of the
DEC Multinational character set.

Passwords Can contain 1 to 31 characters. Valid characters for
passwords are a to z, A to Z, 0 to 9, $, - (hyphen),
_ (underscore), . (period), and the characters in columns 12
to 15 of the DEC Multinational character set.

Terminal address Must be the Ethernet physical address in either format:
08-00-2B-07-61-1D or 08002B07611D

Font set Can contain the same characters used for work group
names.

Optional Name
for terminal in
Create Terminal
dialog box

Can contain 1 to 31 characters. The optional name
can include any displayable ASCII character and the
characters in columns 12 to 15 of the DEC Multinational
character set.
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3.4 Creating Work Groups

The Create menu in the Resource Management dialog box lets you
create work groups for server-based terminals and add terminals
to those work groups. It is a good idea to create separate work
groups for monochrome and color terminals, to avoid conflicting
color settings in the following dialog boxes:

• Terminal manager’s Customize Window Color

• Terminal manager’s Customize Screen Background

• Terminal manager’s Customize Pointer Color

• Window manager’s Workspace: Border Color Options

• Window manager’s Workspace: Icon Color Options

• Window manager’s Workspace: Matte Options

To create a
work group for
management: 1. Display the Resource Management dialog box.

2. Pull down the Create menu.

3. Choose the Create Work Group... menu item to display the
Create Work Group dialog box.
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4. Choose a server for the work group by clicking on that server
in the scroll box. The terminal highlights your selection and
displays the server’s name in the Server box.
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You can also enter the server name directly in the Server box.

5. Click on the Work Group box. Enter the name for the work
group, then press Return .

Work group names can contain up to 31 characters. You
can use the following characters: a to z, A to Z, 0 to 9, $, -
(hyphen), . (period), and the characters in columns 12 to 15 of
the DEC Multinational character set.

6. Enter a password for the work group in the Password box,
then press Return .

7. Enter the password again in the Verification box, then press
Return .

8. Click on Apply or OK. The terminal displays a password dialog
box:
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9. Enter the VXT manager password, then click on OK. The
terminal displays a message box, confirming the work group
was created. The new work group is displayed in the Resource
Management dialog box.

10. Click on OK in the message box.

11. Repeat this procedure for each work group you want to create.

To cancel any creation that you have not applied yet, click on
Cancel. The terminal closes the Create Work Group dialog box
without creating the work group.
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3.5 Creating Terminals in Work Groups

The Create menu in the Resource Management dialog box lets
you create server-based terminals in work groups.

You cannot create duplicate terminal resource files on your
network. If you try to create a terminal that already exists, the
terminal displays a message box indicating the server and work
group where the terminal already resides.

Like Ethernet addresses, terminal resource files must be unique
at your site. If the InfoServer system selected to store a resource
file is unavailable while the create operation is taking place,
a second terminal resource file may be created on the VXT
system. This action leads to different customized settings being
saved and stored on different InfoServer systems. Each time
a terminal starts up, it may choose customized settings from
either InfoServer system. If you become aware that more that
one terminal resource file exists for a terminal, delete one of the
terminals.

To create a server-
based terminal in a
work group: 1. Display the Resource Management dialog box.

2. Pull down the Create menu.

3. Choose the Create Terminal... menu item to display the
Create Terminal dialog box.
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4. Choose a server for the terminal by clicking on that server
in the scroll box. The terminal highlights your selection and
displays the server’s name in the Server box.

5. Double click on the chosen server to display the work groups
on the server.

6. Choose a work group for the terminal by clicking on the work
group in the scroll box. The terminal highlights your selection
and displays the work group’s name in the Work Group box.

7. Click on the Ethernet Address box.

8. Enter the terminal’s Ethernet physical address into the
Ethernet Address box, then press Return .

Example: 11-22-33-44-55-66 or 112233445566

9. If desired, enter an optional name to associate with the
terminal. For example, the terminal’s location, a user name,
or some other identifier.

10. Click on Apply or OK. The terminal displays a password dialog
box:
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11. Enter the VXT manager password or Work Group password,
then click on OK. The terminal displays a message box
confirming the terminal was created.

12. Click on OK in the message box.

13. Repeat this procedure for each terminal you want to create.

To cancel any creation that you have not applied yet, click on
Cancel. The terminal closes the Create Terminal dialog box
without creating the terminal.
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3.6 Choosing a Server, Work Group, or Terminal

When you open the Resource Management dialog box, the scroll
box lists only servers. No work groups or terminals are displayed.
The list includes the known servers on your system that belong to
the currently selected LASTport group code. The Local Terminals
server is for host-based terminals; this server does not actually
exist.

When you double click on a server in the scroll box, the list
expands to show the work groups on that server. When you
double click on a work group, the list expands to show the
terminals in that work group.

After you choose a work group or terminal, you can use the
Customize, Copy, Move, Backup and Delete buttons to configure
the selected work group or terminal. You cannot perform work
group operations on host-based terminals.

When new servers become available on the network, you can
update the server list to display all known servers.

To choose a
work group for
configuration:

You must know what server the work group belongs to. You
cannot perform work group operations on host-based terminals.

1. In the scroll box, double click on the server for the work group.
Your selection becomes highlighted, and the terminal displays
the current list of work groups for that server.

2. Double click on the work group you want to configure. Your
selection becomes highlighted, and the terminal displays the
current list of terminals for that work group. The work group
is now selected for configuration.

To choose a terminal
for configuration:

Follow the procedure for choosing a work group. Then click on
the name of the terminal you want to configure. Your selection
becomes highlighted. If you double click on the terminal name,
the terminal displays the Customize Terminal dialog box.

All host-based terminals belong to the Local Terminals server and
Local work group.

1. Pull down the File menu in the Resource Management dialog
box.

2. Choose Update Known Servers. The terminal updates the list
of servers in the scroll box of the Resource Management dialog
box.

To display servers
for another LASTport
group code:

By default, the Resource Management dialog box displays the
servers in group 0. To display and manage servers, work groups,
and terminals in another group code:
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1. Display the Resource Management dialog box.

2. Pull down the Options menu.

3. Choose the LASTport Group Code... menu item. The terminal
displays the LASTport Group Code dialog box.
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4. Enter the desired group code, from 0 to 1023.

5. Click on OK.

The Resource Management dialog box displays the list of
servers for the new group code. You can now manage the
servers, work groups, and terminals in the new group.

6. To save your LASTport group code setting for future sessions,
click on the Save Options menu item in the Options menu.
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3.7 Finding Work Groups and Terminals

You can use the File menu in the Resource Management dialog
box to find

• A work group’s server

• A terminal’s server and work group

To find a work group: 1. Display the Resource Management dialog box.

2. Pull down the File menu.

3. Choose the Find Work Group... menu item. The terminal
displays the Find Work Group dialog box.
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4. Click on the Work Group box and enter the name of the work
group you want to find.

You can use the asterisk (*) and percent sign (%) wild card
symbols to find work groups with similar names. An asterisk
matches a string of characters, and a percent sign matches
one character.

5. Click on the Find button. If the work group is found, the name
of the work group and its server appear in the scroll box.

If the work group is a backup, the word Yes appears in the
Backup column.

6. Click on the Close button to dismiss the Find Work Group
dialog box.
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To find a terminal: 1. Display the Resource Management dialog box.

2. Pull down the File menu.

3. Choose the Find Terminal... menu item. The terminal displays
the Find Terminal dialog box.
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4. Click on the Ethernet Address box and enter the Ethernet
physical address of the terminal you want to find.

You can use the asterisk (*) and percent sign (%) wild card
symbols to find terminals with similar Ethernet addresses or
list all terminals. An asterisk matches a string of characters,
and a percent sign matches one character.

5. Click on the button to right of the Ethernet Address box to
choose the type of terminals you want to find: server-based
terminals, NVR-based terminals (host-based), or all types.

6. Click on the Find button. If the terminal is found, the name of
the server and work group the terminal is on appears in the
scroll box.

If the terminal is a backup, the word Yes appears in the
Backup column.

7. Click on the Close button to dismiss the Find Terminal dialog
box.
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3.8 Finding Services on InfoServer Systems

You can use the Find Service dialog box to search InfoServer
systems for

• VXT software services. For example, you can do selective or
wild card searches for VXT system images, terminals, work
groups, and pagefiles.

• Services that belong to particular service classes, such as
OpenVMS, ULTRIX, or MS–DOS virtual disks.

The InfoServer system supports multiple operating systems and
on-disk file structures by logically grouping services for each client
system. These groups are based on service classes. Each client
system accesses only the services that are meaningful to it.

The Find Service dialog box is comparable to the InfoServer
system’s SHOW SERVICE command.

To find an InfoServer
service:

1. Display the Resource Management dialog box.

2. Pull down the File menu.

3. Choose the Find Service... menu item. The terminal displays
the Find Service dialog box.
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4. Click on the Service Name box and enter the name of the
service you want to find.

You can use the asterisk (*) and percent sign (%) wild card
symbols to search for services with similar names. An asterisk
matches a string of characters, and a percent sign matches
one character.

5. Click on the Service Class button and choose a service class
from the pop-up menu. You have the following choices:

Unformatted
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MS–DOS virtual disk
VMS virtual disk
ULTRIX virtual disk
ISO 9660 compact disk
MS–DOS compact disk
VXT work group
VXT system
VXT pagefile
Apple hierarchical or flat (volumes)
MOP service name

6. Click on the Find button. The terminal searches all available
InfoServer systems for matching services that belong to the
specified service class. If any matches are found, the terminal
displays them in the scroll box.

For each listed service, the scroll box displays

• The number of connections currently reading and writing
to the service

• The maximum number of connections that can read or
write to the service

• The service rating for the service

• The disk size of the service in 512 byte blocks
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3.9 Customizing Work Groups and Terminals

You can configure settings for items on the following menus so
that work groups and terminals can share them:

• Terminal Manager window’s Customize menu

• Terminal Manager window’s Create menu

• Window manager’s Options submenu (work group only)

• VXT DECterm Options menu (work group only)

You can also lock or unlock the customized settings, which
determines whether users can change the settings on their
individual terminals. Depending on the menu, you can prevent
users from viewing dialog boxes or the menu itself.

You use the Resource Management dialog box, you select a
work group or terminal for customization. After you select the
work group or terminal, the configuration manager displays the
Customize Work Group or Customize Terminal dialog box.

Notes on
Customizing

• VXT Version 2.1 software lets you use the configuration
manager to customize the terminal you are currently using.
Previously, you had to customize your terminal from the
configuration manager on another terminal.

• All host-based terminals are under the Local Terminals server
and Local work group. You cannot customize the Local work
group, but you can customize the individual terminals in the
work group.

• Before you can customize DECnet, LASTport, or primary boot
settings from the configuration manager, you must enable the
NVRAM synchronization feature (Section 3.10).

New customized settings take effect when you restart the affected
terminals.

To customize a work
group or terminal:

1. Display the Resource Management dialog box.

2. In the scroll box, double click on the server for the work group.
The list expands to show the work groups for that server.
Host-based terminals are always under the Local Terminals
server and Local work group.

3. Double click on the work group you want to customize. The
list expands to show the terminals included in that work
group.

If you are customizing a terminal, click on the terminal you
want to customize.

4. After you choose the work group or terminal, click on the
Customize... button. The terminal displays a Password dialog
box for the terminal or work group.
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For Work Groups:
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For Server-Based
Terminals:
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For Host-Based
Terminals:
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5. Enter the password for the support server or the work group.

6. Click on OK. The terminal verifies the password, then displays
the Customize Work Group or Customize Terminal dialog box.
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Customize Work
Group Dialog Box
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Prevent User
Customization

The Customize Work Group dialog box contains a Prevent User
Customization button. When set, this button prevents terminals
from saving any customized settings. To prevent users from
customizing their terminal settings and saving them, click on
Prevent User Customization.
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Customize Terminal
Dialog Box
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Work Group Settings The Customize Terminal dialog box contains a Work Group
Settings button. This button lets terminals use the same settings
as the work group they belong to. To set the terminal to use the
work group settings, click on Work Group Settings.

The Customize Work Group and Customize Terminal dialog boxes
are divided into three sections:

• Terminal Manager Customizations

• DECterm Customizations

• Motif Window Manager Customizations
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3.9.1 Terminal
Manager
Customizations

From the scroll box in the Customize Work Group or Customize
Terminal dialog box, you can display and change the settings
for any of the Terminal Manager window’s Customize or Create
dialog boxes. You can also lock or unlock each dialog box.

To customize dialog
box settings for
a work group or
terminal:

1. In the scroll box, click on the name of the dialog box you want
to customize.

2. Click on the Select button. The terminal displays the selected
Customize or Create dialog box.

3. Use your mouse and keyboard to make changes. See
VXT 2000+/VXT 2000 Windowing Terminal User Information

for descriptions of Customize and Create dialog boxes.

System Defaults button: If you press the System Defaults
button in a Customize dialog box while customizing a work
group, the Customize dialog box displays its factory-default
settings.

If you press the System Defaults button while customizing
a terminal, the Customize dialog box displays the terminal’s
work group settings.

4. Click on OK in the dialog box to save your settings.

Repeat this procedure for each dialog box you want to customize.

To lock or unlock
Terminal Manager
customizations:

Individual Dialog Boxes

1. In the scroll box, click on the name of the dialog box you want
to lock or unlock.

2. There are three buttons to the right of the scroll box. Use the
top button to lock or unlock the dialog box. The button’s label
changes when you click on the button.

If the button’s label is Lock, clicking on the button locks the
selected dialog box. If the button’s label is Unlock, clicking on
the button unlocks the selected dialog box.

When you lock an individual dialog box, users cannot view
that dialog box. The menu item for displaying the dialog box
is dimmed on the Create or Customize menu in all affected
terminals. The menus remain viewable, and users can still
choose other menu items that are not locked.

3. Repeat this procedure for each dialog box you wish to lock.

4. Click on Apply or OK to save your settings. If you click on
OK, you also close the dialog box.

Click on Cancel if you do not want to save the changes.

All Dialog Boxes

To lock or unlock all of the Terminal Manager window’s Create
and Customize dialog boxes for a selected work group, use the
Lock All button or Unlock All button. If you lock all dialog boxes,
all menu items in the Create and Customize menus are dimmed

3–24 VXT Software: Managing Terminals and Work Groups



Using the Configuration Manager
3.9 Customizing Work Groups and Terminals

on affected terminals. The menus are still viewable, but users
cannot choose the menu items.

Click on Apply or OK to save the setting. If you click on OK, you
also close the dialog box.

Click on Cancel if you do not want to save the changes.

3.9.2 DECterm
Customizations

You can customize DECterm options for a work group by
customizing the VXT DECterm settings of the terminal you
are using for configuration, then applying the settings to a work
group. Customizations for a terminal must be done at each
terminal.

You can lock or unlock the DECterm window’s Options dialog
boxes for a work group or terminal. If you lock the settings, you
can also prevent users from viewing the locked dialog boxes.

To customize VXT
DECterm options for
a work group:

First, you must customize and save the VXT DECterm settings
on your terminal. To do this, create a VXT DECterm window
and use the Options menu in the window to customize settings
(VXT 2000+/VXT 2000 Windowing Terminal User Information).
Then save the settings with the Save Options menu item in
the VXT DECterm window’s Options menu. After you save
your settings, you can apply them to a work group by using the
Customize Work Group dialog box:

1. Click on the Apply Local Terminal Settings button.

2. Click on Apply or OK to save the new settings. If you click on
OK, you also close the dialog box.

Click on Cancel if you do not want to save the changes.

You cannot customize VXT DECterm options for a terminal
from the configuration manager. You must customize the
settings at the particular terminal, using the VXT DECterm
window’s Options menu.

To lock or unlock
VXT DECterm
customizations:

1. Click on the Lock Customizations button.

If you lock the settings, users cannot save new VXT DECterm
settings from their terminal. They cannot view the Options
menu in VXT DECterm windows, unless you use the Locked
Screens Visible button to make the menu visible. If the menu
is not visible, the Options menu name is dimmed.

2. Click on Apply or OK to save the setting. If you click on OK,
you also close the dialog box.

Click on Cancel if you do not want to save the changes.
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To let users view
locked DECterm
customizations:

1. Click on the Locked Screens Visible button.

This allows users to display the Options menu in VXT
DECterm windows and view dialog boxes from the menu.
However, users cannot save their VXT DECterm settings
because the Save Options menu item in VXT DECterm
window’s Options menu is dimmed.

2. Click on Apply or OK to save the setting. If you click on OK,
you also close the dialog box.

Click on Cancel if you do not want to save the changes.

3.9.3 Window
Manager
Customizations

You can customize the window manager options for a work
group by customizing the settings of the terminal you are using
for configuration, then applying the settings to a work group.
Customizations for a terminal must be done at each terminal.

You can also lock or unlock the customized settings for the window
manager.

To customize the
window manager
settings for a work
group:

First, you must customize and save the window manager
settings on your terminal. To do this, use the Options submenu
(VXT 2000+/VXT 2000 Windowing Terminal User Information).

The Options submenu is available from the window menu button
or the pop-up Workspace submenu. After you customize settings,
save them by using the Restart... menu item in the Workspace
submenu. After you save the settings:

1. Click on the Apply Local Terminal Settings button.

2. Click on Apply or OK to save the setting. If you click on OK,
you also close the dialog box.

Click on Cancel if you do not want to save the changes.

You cannot customize the window manager settings for
a terminal from the configuration manager. You must
customize the settings at the particular terminal, using the
Options menu available from the window menu button or pop-up
Workspace submenu.

To lock or unlock
window manager
customizations:

1. Click on the Lock Customizations button.

If you lock the settings, the Options submenu item in the
Workspace submenu is dimmed on all affected terminals. This
prevents users from displaying the Options submenu.

2. Click on Apply or OK to save the setting. If you click on OK,
you also close the dialog box.

Click on Cancel if you do not want to save the changes.
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3.10 Customizing DECnet, LASTport, or Primary Boot Settings

When you customize a terminal or work group, the settings are
written to the terminal or work group resource file. DECnet,
LASTport, and primary boot settings also reside in a special
section of the terminal’s NVRAM memory.

Feature Dialog Box Can Be Customized For

DECnet Customize DECnet Terminal

LASTport group
code (for server-
based terminals)

Customize
LASTport

Terminal or work group

Primary boot
settings (for loading
the terminal’s VXT
software)

Customize Boot Terminal or work group

Before you can customize DECnet, LASTport, or primary boot
settings from the configuration manager, you must enable the
Synchronize NVRAM feature for the terminal or work group, as
follows.

3.10.1 Sync
NVRAM

You can use the Synchronize NVRAM dialog box to synchronize
the settings in a terminal’s NVRAM memory with the settings in
its terminal or work group resource files.

By default, synchronization is off. You must enable
synchronization before you can customize DECnet, LASTport,
or primary boot settings from the configuration manager.

To synchronize
NVRAM settings:

1. Display the Resource Management dialog box.

2. Pull down the Options menu.

3. Choose the NVRAM Synchronize... menu item to display the
Synchronize NVRAM dialog box.
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4. You can synchronize settings for terminal operations, work
group operations, or both. Click on the appropriate buttons.

5. Click on OK to save your settings for this session and close the
dialog box.
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Your NVRAM synchronization settings apply to subsequent
terminal and work group operations you perform from the
configuration manager.

6. If you want to save your Synchronize NVRAM settings for
future sessions, click on the Save Options menu item in the
Options menu.

7. Customize the desired terminals or work groups from the
configuration manager.
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3.11 Copying Work Group Customizations

You can copy the customizations of one work group (source) to
another work group (destination). The work groups may reside on
the same server or a different server. You cannot perform work
group operations for host-based terminals.

You choose the source work group in the Resource Management
scroll box. Then you enter the destination work group and server
in the Copy Work Group dialog box.

The destination work group must already exist on a server before
you copy work group customizations. To create a work group, see
Section 3.5.

To copy the
customizations
of one work group to
another:

1. Display the Resource Management dialog box.

In the dialog box, the scroll box displays the list of available
servers.

2. In the scroll box, choose the source work group.

a. Double click on the server where the source work group
resides. The list expands to show the work groups for that
server.

b. Click on the source work group. Your selection is
highlighted.

3. Click on the Copy button to display the Copy Work Group
dialog box. (Or choose the Copy... menu item from the
Maintenance menu.)
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4. Enter the destination server and work group in the Copy Work
Group dialog box.

a. If necessary, click on the scroll bar in the Copy Work Group
dialog box to display the name of the destination server
where the destination work group resides.

b. Double click on the name of the server in the scroll box.
The server’s name is highlighted and displayed in the
Server: box. The list expands to show the work groups on
the server.

c. Click on the name of the destination work group in the
scroll box. The destination work group is highlighted in
the scroll box and displayed in the Work Group: box.

5. Click on Apply or OK. The terminal displays a Password
dialog box for copying work groups.
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6. Enter the password for the destination work group into the
Enter Password box.

7. Click on OK. The terminal displays a message box confirming
the work group’s customizations were copied.

To cancel a copy operation that you have not applied yet, click on
Cancel.
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3.12 Copying Terminal Customizations

You can copy the customizations of one terminal (source) to
another terminal (destination). The terminals may reside in the
same or different work group or server. You choose the source
terminal in the Resource Management scroll box. Then you enter
the destination terminal, work group, and in the Copy Terminal
dialog box.

The destination terminal must already exist in a work group on
a server before you copy terminal customizations. To create a
terminal, see Section 3.5. You can also move a terminal and its
customizations to another work group. See Section 3.13.

IP Addresses, DECnet Addresses, Terminal Names Not Copied

If the source terminal has an IP address or DECnet
address, those addresses are not copied to the destination
terminal. Optional terminal names are also not copied.

To copy the
customizations
of one terminal to
another:

1. Display the Resource Management dialog box.

In the dialog box, the scroll box displays the list of available
servers.

2. In the scroll box, select the source terminal.

a. Double click on the server where the source terminal
resides. The list expands to show the work groups for that
server.

b. Double click on the work group where the source terminal
resides. The list expands to show the terminals for that
work group.

c. Click on the source terminal. Your selection is
highlighted.

3. Click on the Copy button to display the Copy Terminal dialog
box. (Or choose the Copy... menu item from the Maintenance
menu.)
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4. Enter the destination server, work group, and terminal into
the Copy Terminal dialog box.

a. If necessary, click on the scroll bar in the Copy Terminal
dialog box to display the name of the destination server
where the destination terminal resides.

b. Double click on the name of the server in the scroll box.
The server’s name is highlighted and displayed in the
Server box. The list expands to show the work groups on
the server.

c. Double click on the name of the destination work group in
the scroll box. The work group name is highlighted and
displayed in the Work Group box. The list expands to show
the terminals in the work group.

d. Click on the name of the destination terminal in the scroll
box. The destination terminal is highlighted in the scroll
box and displayed in the Ethernet Address box.

5. Click on Apply or OK. The terminal displays a Password
dialog box for copying terminals.
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6. Enter the destination work group or VXT manager password
into the Password dialog box.

a. Click on the Work Group Password button or VXT Manager
Password button.

b. Enter the destination Work Group password or destination
VXT manager password in the Enter Password box.

7. Click on OK in the Password dialog box. A message box
appears confirming the terminal’s customizations were copied.

To cancel a copy operation that you have not applied yet, click on
Cancel.
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3.13 Moving Terminals Among Work Groups

You can move a single terminal or a group of terminals from one
work group (source) to another work group (destination). The
work groups may be on the same or different servers. You cannot
perform work group operations for host-based terminals.

You choose the terminals you want to move in the Resource
Management scroll box. Then you enter the destination work
group and server in the Move Terminals dialog box.

The destination work group must exist on the destination server
before you move terminals. Terminals that are moved into a new
work group retain their terminal customizations but inherit the
work group customizations of the new work group.

To move terminals to
a new work group:

1. Display the Resource Management dialog box.

In the dialog box, the scroll box displays the list of available
servers.

2. In the scroll box, select the terminal or terminals you want to
move.

a. Double click on the server where the terminals you want to
move reside. The list expands to show the work groups for
that server.

b. Double click on the work group where the terminals
you want to move reside. The list expands to show the
terminals for that work group.

c. Click and drag MB1 over the terminals you want to move.
The selected terminals become highlighted.

3. Click on the Move button to display the Move Terminals dialog
box. (Or choose the Move... menu item from the Maintenance
menu.)
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4. Enter the destination server and work group into the Move
Terminals dialog box.

a. Double click on the name of the server that supports the
terminal’s new work group. The list expands to show
the work groups on that server. The server’s name is
highlighted in the scroll box and displayed in the Server
box.

b. If necessary, click on the scroll bar in the Move Terminals
dialog box to display the names of the destination server
and destination work group.

c. Click on the destination work group in the scroll box. The
destination work group is highlighted in the scroll box and
displayed in the Work Group box.

5. Click on Apply or OK. The terminal displays a Password
dialog box for moving terminals.
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A faster way to move
terminals to a new
work group:

You can also move terminals from one work group list to another
in the Resource Management scroll box, without displaying the
Move Terminals dialog box. You can move several terminals at a
time, if they are listed in order.

1. Display the Resource Management dialog box.

In the dialog box, the scroll box displays the list of available
servers.

2. In the scroll box, display the source and destination work
groups.

a. If you are moving the terminals to a different server,
double click on the destination server. The list expands to
show the work groups for the destination server.

b. Double click on the source server where the terminals you
want to move reside. The list expands to show the work
groups for the source server.

3. Select and move the terminals from the source to the
destination work group.

a. Double click on the source work group where the terminals
you are moving reside. The list expands to show the
terminals for the source work group.

b. Click and hold down MB1 on the first terminal that
you want to move. Drag the cursor down across the
terminals you want to move. The selected terminals
become highlighted. Release MB1.

c. Click and hold down MB2 on the first terminal you
selected. The selected terminals become outlined with
boxes.

d. While holding down MB2, move the outline of the first
terminal box on or over the destination work group.

e. Release MB2. The terminal displays a Password dialog box
for moving terminals.
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1. Click on the Work Group Password or VXT Manager Password
button for the source password.

2. Enter the source work group password or source VXT manager
password.

3. Click on the Work Group Password or VXT Manager Password
button for the destination password.

4. Enter the destination work group password or destination
VXT manager password.

5. Click on OK. A terminal displays a message box confirming
the terminals were moved.

To cancel a move operation that you have not applied yet, click on
Cancel.
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3.14 Backing Up Work Group or Terminal Customizations

You can copy work group and terminal customizations from a
primary support server to a backup support server. The backup
support server can then read the terminal customizations if the
primary server is unavailable when a terminal starts up. You
cannot perform work group operations for host-based terminals.

In a backup procedure, you back up customizations from one work
group (source) to another work group (destination), or from one
terminal to another terminal. Terminals may be on the same
server or different servers. When you back up a work group,
you can also back up terminals within the work group. If the
destination work group or terminal does not already exist on the
destination server, it is created.

The following restrictions apply when backing up terminals to the
Local terminals server or Local work group:

• You can back up a terminal to the Local Terminals server only
if the destination local terminal already exists.

• You can back up a terminal to the Local work group only if the
terminal already exists in the Local work group.

When you display backup work groups or terminals in the
Resource Management scroll box, a backup icon appears before
the work group or terminal icon.

VXT Loader Software
Requirement

To take advantage of the backup procedure, you need the VXT
loader Version 1.1 or higher installed on the host or InfoServer
system.

You can create many backup copies of work group and terminal
resource files on multiple servers. Users can save customizations
to backup terminal resource files if the primary customization
files are unavailable for use. The VXT manager is responsible for
maintaining consistency between primary and backup files.

3.14.1 Backing
Up a Work
Group

To back up the customizations of one work group to another, you
first choose the source work group in the Resource Management
scroll box. Then you enter the destination work group and server
in the Backup Work Group dialog box.

To back up the
customizations of
one work group to
another:

1. Display the Resource Management dialog box.

In the dialog box, the scroll box displays the list of available
servers.

2. In the scroll box, choose the source work group you want to
back up.

a. Double click on the server where the source work group
resides. The list expands to show the work groups for that
server.

b. Click on the source work group. Your selection is
highlighted.
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3. Click on the Backup button to display the Backup Work Group
dialog box. (Or choose the Backup... menu item from the
Maintenance menu.)

4. Enter the destination server into the Backup Work Group
dialog box.

a. If necessary, click on the scroll bar in the Backup Work
Group dialog box to display the name of the destination
server.

b. Double click on the name of the server in the scroll box.
The server’s name is highlighted and displayed in the
Server box. The list expands to show the work groups on
the server.

5. Enter the destination work group into the Backup Work Group
dialog box.

If the backup work
group already exists
on the server:

1. Click on the name of the destination work group in the scroll
box. The destination work group is highlighted in the scroll
box and displayed in the Work Group box.

2. Click on the Password box.

3. Enter the password associated with the backup work group.
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4. By default, terminals in the work group are also backed up.
Click on the Backup Terminals button if you do not want to
back up the terminals within the work group.

5. Click on Apply or OK. The terminal displays a message box
confirming the backup was completed.

If you are creating
a new backup work
group:

1. Click on the Work Group box and enter a name for the backup
work group, then press Return . You can use the same name as
the source work group or use a new name.

2. Enter a password to associate with the backup work group.

3. Click on the Backup Terminals button if you do not want to
back up the terminals within the work group.

4. Click on Apply or OK. The terminal displays a Password
dialog box requesting the VXT manager password.
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5. Enter the VXT manager password for the destination server in
the Enter Password box.

6. Click on OK or press Return .

The terminal displays a message box confirming the backup
was completed. The backup terminal and backup work group
files are displayed in the Resource Management scroll box,
along with the backup icon.

To cancel a backup operation that you have not applied yet, click
on Cancel.

3.14.2 Backing
Up Terminal
Customizations

To back up the customizations of one terminal to another, you
choose the source terminal in the Resource Management scroll
box. Then you enter the destination terminal, work group, and
server in the Backup Terminal dialog box.
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To back up the
customizations of
one terminal to
another:

1. Display the Resource Management dialog box.

In the dialog box, the scroll box displays the list of available
servers.

2. In the scroll box, choose the source terminal.

a. Double click on the server where the source work group
resides. The list expands to show the work groups for that
server.

b. Double click on the work group where the source terminal
resides. The list expands to show the terminals for that
work group.

c. Click on the source terminal. Your selection is
highlighted.

3. Click on the Backup button to display the Backup Terminal
dialog box. (Or choose the Backup... menu item from the
Maintenance menu.)

4. Enter the destination server and work group into the Backup
Terminal dialog box.

a. If necessary, click on the scroll bar in the Backup Terminal
dialog box to display the name of the destination server
where the destination work group resides.

b. Double click on the name of the server in the scroll box.
The server’s name is highlighted and displayed in the
Server box. The list expands to show the work groups on
the server.
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c. If necessary, click on the scroll bar in the Backup Terminal
dialog box to display the name of the destination work
group.

d. Click on the name of the destination work group in the
scroll box. The destination work group is highlighted in
the scroll box and displayed in the Work Group box.

5. Click on Apply or OK.

If the backup terminal already exists on the server:
The terminal displays a message box confirming the backup
operation was completed.

If you are creating a new backup terminal: The terminal
displays Password dialog box requesting the VXT manager or
work group password.
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6. Enter the password for the destination work group or the VXT
manager password into the Enter Password box.

7. Click on OK or press Return .

The terminal displays a message box confirming the backup
operation was completed. The backup terminal resource file is
displayed in the Resource Management dialog box, along with
the backup icon.

To cancel a backup operation that you have not applied yet, click
on Cancel.
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3.15 Changing Passwords for Work Groups

You can change the password for a work group. The password
controls access to management commands for that work group.

If you have lost or forgotten the work group password and the
VXT manager password, you cannot change the password for the
work group from the terminal. Similarly, you cannot change the
VXT manager password from the terminal. To change the work
group password or VXT manager password, see the InfoServer
chapters on this guide.

To change the
password for a work
group:

1. Display the Resource Management dialog box.

In the dialog box, the scroll box displays the list of available
servers.

2. Double click on the support server for the work group whose
password you want to change.

3. Click on the work group.

4. Pull down the Maintenance menu.

5. Click on the Change Password... menu item to display the
Change Work Group Password dialog box.
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6. Enter the old password and press Return .

7. Enter the new password and press Return .

8. Enter the new password again in the Verification box.

9. Click on OK. The password changes, and the Change Password
dialog box closes.

To cancel the operation, click on Cancel.

To clear all text-entry boxes, click on Clear.
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3.16 Changing Passwords for Host-Based Terminals

You can change the password for a host-based terminal in the
Local work group. The password controls access to management
commands for that terminal.

The default password for all host-based terminals in the Local
work group is VXTNVR.

To change the
password for a
host-based terminal:

1. Display the Resource Management dialog box.

In the dialog box, the scroll box displays the list of available
servers.

2. Double click on the Local Terminals server.

3. Click on the Local work group.

4. Pull down the Maintenance menu.

5. Click on the Change Password... menu item to display the
Change Terminal Password dialog box.
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6. Enter the old password and press Return .

7. Enter the new password and press Return .

8. Enter the new password again in the Verification box.

9. Click on OK. The password changes, and the Change Terminal
Password dialog box closes.

To cancel the operation, click on Cancel.

To clear all text-entry boxes, click on Clear.
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3.17 Deleting Work Groups and Terminals

You can delete a selected work group or terminal configuration
from the Resource Management dialog box.

You cannot delete the Local work group or any terminals in the
Local work group.

To delete a work
group or terminal:

1. Display the Resource Management dialog box.

In the dialog box, the scroll box displays the list of available
servers.

2. In the scroll box, double click on the server that contains the
work group or terminal you wish to delete. The list expands to
show the work groups on the server.

3. If you are deleting a work group, click on the work group you
want to delete. The work group is highlighted.

If you are deleting a terminal, double click on the work
group that contains the terminal you wish to delete. The list
expands to show the terminals in the work group. Click on the
terminal you want to delete. The terminal is highlighted.

4. Pull down the Maintenance menu.

5. Click on the Delete menu item. The terminal displays a box
asking you to confirm that you want to delete the work group
or terminal.

To cancel the operation, click on No.

To continue, click on Yes. The terminal may display a
Password dialog box.
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6. Enter the VXT manager password or work group password
and click on OK. The terminal displays a message box
confirming that the work group or terminal was deleted.

7. Repeat this procedure for each work group or terminal you
want to delete.

To cancel a delete operation that you have not applied yet,
click on Cancel.
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3.18 Exiting from the Resource Management Dialog Box

To exit from the Resource Management dialog box, click on the
Close button in the dialog box.
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3.19 Managing Fonts

You can use the configuration manager to manage font sets
available on servers with the same LASTport group code as the
terminal. You can view the list of font sets and create, copy, or
remove font sets. You can also view the list of fonts within a font
set.

Font Formats The fonts provided with the VXT Version 2.1 software kit for
InfoServer systems are in compressed portable compiled font
(PCF) format. InfoServer systems can also store fonts in other
formats suitable for your host applications. To store other host
fonts on the InfoServer system, you create font sets as described
in this chapter.

Font Management
Dialog Box

To manage font sets, you use the Font Management dialog box.
To display this dialog box, pull down the Customize menu in the
Terminal Manager window. Choose the Configuration submenu
menu item. From the Configuration submenu, choose the Font
Management... menu item. The Font Management dialog box
looks like this:
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 SERVER _  1

SERVER _   2

SERVER _   3

  
  

 

  
  SERVER _  4

Font Sets Scroll Box The Font Sets scroll box lists the font sets installed on each
known support server. Font sets are listed by name, the server
they reside on, the transport method, and number of fonts in the
set. You can also display the list of fonts in a font set from this
scroll box.

To display the list of
fonts in a font set:

1. Click on the font set in the Font Sets scroll box. Your selection
is highlighted.

2. Click on the List Contents... button. The terminal displays a
scroll box that lists the font format and name of each font in
the font set.
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Quicker method: Double click on the font set name in the Font
Sets scroll box.

3–48 VXT Software: Managing Terminals and Work Groups



Using the Configuration Manager
3.20 Creating Font Sets

3.20 Creating Font Sets

You can create a new font set from sets of source font files on one
or more remote host systems. You can also save a list of source
font source information for creating font sets.

Display the Create
Font Set dialog box.

1. Display the Font Management dialog box.

2. Click on the Create... button to display the Create Font Set
dialog box.
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Enter your font
paths.

The Get Font Date From scroll box lists the paths to the source
fonts you want to include in the font set. You can enter multiple
paths, using any of the available transports. To enter a source
font path:

1. In the Transport box, click on the transport used to
communicate with the host: NFS, TFTP, or LAT.

2. For LAT or TFTP: enter the name of the host system in the
Host box.

For NFS: enter the NFS mount point in the Mount box.
Before you can enter mount points, you must define them in
the Customize NFS dialog box.

3. In the Path box, enter the directory path to the font source
files.
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For TFTP: The directory path must refer to a file containing
a list of all font files included in the font set. Each font file in
the list should be explicitly defined.

For LAT: You can use system-level logicals to specify the
directory path.

4. Click on the " button to add the source font information to the
scroll box.

5. Repeat these steps for each source font set you want to include
in your InfoServer font set. Source font sets are read in the
order you list them.

You can use the 4 and 5 buttons to reorder your list. Click
on a font set in the scroll box, then click on the appropriate
button to move the font set up or down one line.

To delete a source font set from the scroll box, click on the
trash can button.

Create the font set. After you enter source font set paths, you can create the
InfoServer font set:

1. In the Font Set Name box, enter the name you want to use for
the font set.

2. In the On Server box, enter the name of the InfoServer where
the font set will reside.

3. In the Password box, enter a password to associate with the
font set. The terminal does not display your password.

4. Click on OK to create the font set and close the Create Font
Set dialog box.

To cancel the operation and close the dialog box, click on
Cancel.

To clear the text-entry boxes, click on Reset. Reset does not
clear the source font information in the scroll box.

The Get Font Data From scroll box saves the source font
information you enter, so you can reuse this information the
next time you to create font sets.

3–50 VXT Software: Managing Terminals and Work Groups



Using the Configuration Manager
3.21 Copying Font Sets

3.21 Copying Font Sets

You can copy font sets from one support server to another, to
make the fonts available to work groups and terminals on the
new server. You can also use the copy function to rename a font
set on a server.

To copy font sets to
another server:

1. Display the Font Management dialog box.

2. In the scroll box, click on the font set you want to copy.

3. Click on the Copy... button to display the Copy Font Set dialog
box.
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The dialog box lists the font set and server that you selected.

4. Enter the name of the destination server in the To Server box.
Then press Return .

5. Click on the Same Name button if you are copying the font set
to another server.

Click on the New Name button if you are renaming a font set
on the same server or copying a font set to a different server.
Enter a new font set name.

6. Create and enter a password to associate with the font set,
then press Return .

7. Click on OK to copy the font sets and close the dialog box.

To cancel the operation and close the dialog box, click on
Cancel.

To clear the text-entry boxes, click on Reset. Then reenter
your information.
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3.22 Removing Font Sets

You can remove a font set from its server.

To remove a font set: 1. Display the Font Management dialog box.

2. In the scroll box, click on the font set you want to remove.
Your selection is highlighted.

3. Click on the Remove... button. The terminal displays a
Password dialog box.
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4. Enter the font password into the Enter Password box.

5. Click on OK to remove the font set.

To cancel the operation and close the dialog box, click on
Cancel.

To clear the Enter Password box, click on Reset. Then reenter
your password.

3.23 Exiting from Font Management Dialog Box

To exit from the Font Management dialog box, click on the Cancel
button in the dialog box.
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3–22
Customizing

terminals, 3–20
work groups, 3–20

Terminal Manager window, 3–24
VXT DECterm window, 3–25
window manager, 3–26

D
DECnet transport

using, 3–27
Deleting

work groups and terminals, 3–45
Display color

customizing, 2–12

F
File menu (CM), 3–8, 3–14

Find Terminal dialog box, 3–17
Find Work Group dialog box, 3–16

Find Terminal dialog box (CM), 3–17
Find Work Group dialog box (CM), 3–16
Font

managing, 3–47 to 3–52
Font Management dialog box (CM), 3–47

Copy Font Set dialog box, 3–51
Create Font Set dialog box, 3–49
exiting from, 3–52

Font names
listing, 3–47, 3–52

Font set
copying, 3–51
creating, 3–49
removing, 3–52
renaming, 3–51

Font set scroll box (CM), 3–47
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H
Host-based resource file, 2–1

adding other resources, 2–11
compared to configuration manager, 1–1
composite resource file, 2–5
creating, 2–2
Customize Resource Files dialog box, 2–6
customizing display colors, 2–12
customizing the window manager, 2–11
displaying the list of active files, 2–11
entering comments, 2–3
example, 2–4
file name syntax, 2–7
format, 2–1
including other resource files, 2–4
specifying, 2–6
substitute characters, 2–8
syntax, 2–3
template, 2–1, 2–2, 2–13

Host-based terminal, 3–6
change password, 3–44
choosing for configuration, 3–14
configuration manager, 3–6

terminal password, 3–7
finding for configuration, 3–16
host-based resource files, 2–1
managing, 1–3

I
Icon

backup, 3–5, 3–38
backup terminal, 3–8
backup work group, 3–8
server, 3–8
terminal, 3–8
work group, 3–8

InfoServer operating system
finding services, 3–18
LASTport group code, 3–2

K
Key name, in resource file, 2–5

L
LASTport group code, 3–2

customizing, 3–27
LASTport Group Code (CM), 3–14
LAT protocol

specifying font sets, 3–50
Local Terminals server, 3–6
Local work group, 3–6

Locking
customized settings, 3–22, 3–24
DECterm settings, 3–25
window manager settings, 3–26

M
Maintenance menu (CM), 3–9, 3–43, 3–44
Managing

fonts, 3–47 to 3–52
server-based terminals, 3–2
terminals, 3–8 to 3–46

configuration manager, 3–1
host-based resource files, 2–1
overview, 1–1

work groups, 3–8 to 3–46
Move Terminals dialog box (CM), 3–34
.mwmrc file

effect on VXT Create pop-up menu, 2–12
.mwmrc file, 2–11

N
Native resource file, 1–1

definition, 3–3
NVR-based terminals, 3–6
NVRAM

synchronizing settings in, 3–27

O
Options menu (CM), 3–9

P
Password

host-based terminals, 3–7
VXT manager password, 3–3
work groups, 3–43, 3–44

Password dialog box (CM)
for backing up a terminal, 3–42
for backing up a work group, 3–40
for copying a work group, 3–30
for copying terminals, 3–32
for creating terminals, 3–13
for customizing host-based terminals,

3–21
for customizing server-based terminals,

3–21
for customizing work groups, 3–21
for deleting a work group, 3–45
for moving terminals, 3–36
for removing fonts, 3–52
VXT manager password, 3–11

Prevent User Customization button (CM),
3–22
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R
Read-only terminal, 3–3, 3–22

Unregistered Terminals work group, 3–4
Resource file

See also Host-based resource file, Native
resource file.

host-based, 1–1
new terminals, 2–11
Xrm syntax, 2–1

Resource Management dialog box (CM), 3–8
Backup Terminal dialog box, 3–41
Backup Work Group dialog box, 3–39
Change Terminal Password dialog box,

3–44
Change Work Group Password dialog box,

3–43
choosing a work group or terminal in,

3–14
Copy Terminal dialog box, 3–31
Copy Work Group dialog box, 3–29
Create menu, 3–8, 3–10
Create Terminal dialog box, 3–12
Customize Terminal dialog box, 3–23
Customize Work Group dialog box, 3–22
displaying servers by group code, 3–14
File menu, 3–8, 3–14
finding a work group or terminal, 3–16
finding terminals, 3–17
finding work groups, 3–16
Maintenance menu, 3–9, 3–43, 3–44
Move Terminals dialog box, 3–34
Options menu, 3–1, 3–9
scroll box, 3–8
Synchronize NVRAM dialog box, 3–27
updating the list of servers, 3–14

Resource Management window
exiting from, 3–46

rgb.txt file, 2–12

S
Server-based terminal

adding to a work group, 3–12
choosing for configuration, 3–14
configuration manager, 3–2
finding for configuration, 3–16
host-based resource files, 2–1
LASTport group code, 3–2
managing, 1–5
work group, 3–10

Servers
updating the list of, 3–14

SET SERVER LASTPORT GROUP, 3–2
Support server

copying, 3–51

Synchronize NVRAM dialog box, 3–27

T
Terminal customization files

service ratings, 3–38
Terminal Manager window

customizing
for work groups, 3–24

locking settings
for a work group, 3–24

Terminals, managing, 3–8 to 3–46
backing up, 3–4
backing up customized settings, 3–40
choosing a server for, 3–13
choosing a work group for, 3–13
copying customized settings, 3–31
customizing, 3–20
customizing from the Configuration

Manager, 3–24
deleting, 3–45
getting started with work groups, 3–2
locking customized settings, 3–24
locking DECterm settings, 3–25
locking window manager settings, 3–26
moving among work groups, 3–34
using work group settings, 3–23

TFTP
specifying font sets, 3–50

U
Unlocking

customized settings, 3–24
DECterm settings, 3–25
window manager settings, 3–26

Unregistered Terminals work group, 3–3
Update Known Servers (CM), 3–14

V
VXT Create pop-up menu

effected by window manager file, 2–12
VXT DECterm windows

locking settings
for a work group, 3–25

VXT manager password, 3–3
vxtcfgtmpl.xrm resource file, 2–1

W
Window manager

customizing, 2–11
locking settings

for a work group, 3–26
Work group

backing up, 3–4
backing up customized settings, 3–38
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Work group (cont’d)

change password, 3–43
choosing for configuration, 3–14
copying customized settings, 3–29
creating, 3–10
customization files

service ratings, 3–38
customizing, 3–20, 3–24
definition, 3–3
deleting, 3–45
finding for configuration, 3–16
for host-based terminals, 3–6

getting started, 3–2
locking customized settings, 3–24
locking DECterm settings, 3–25
locking window manager settings, 3–26
managing, 3–8 to 3–46
moving terminals to, 3–34
passwords

changing, 3–43, 3–44
policies, 3–5
specifying a password, 3–11
Unregistered Terminals work group, 3–3

Work Group Settings button (CM), 3–23
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